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Copyright
Copyright © 2015 Stratasys Ltd. All rights reserved.
This documentation contains proprietary information of Stratasys Ltd. This information is supplied
solely to assist authorized users of Stratasys P750K 3D printing systems. No part of this document
may be used for other purposes, and it may not be disclosed to other parties.
The specifications on which this document is based are subject to change without notice.
No part of this book may be reproduced in any form or by any means, nor stored in a database or
retrieval system, without prior permission in writing from Stratasys Ltd.
If this document is distributed as a PDF file, you may print it for internal use.

Trademarks
The following are registered trademarks of Stratasys Ltd.: Stratasys®, Objet®, FullCure®.
The following are trademarks of Stratasys Ltd.: Connex, Connex500, Connex350, Objet260 Connex,
PolyJet, Objet Studio, Job Manager.
Microsoft and Microsoft XP are trademarks of Microsoft Corporation.
All names of products and services cited in this book are trademarks or registered trademarks of their
respective companies.

FCC Compliance
The equipment referred to in this guide has been tested and found to comply with the limits for a
Class A device pursuant to part 15 of the FCC rules. These limits provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. Stratasys
3D printing systems generate, use and can radiate radio frequency energy and, if not installed and
used in accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause harmful
interference, in which case the user will be required to correct the interference at his own expense.
The 3D printer referred to in this guide contains a transmitter module, FCC ID YH6 DUPCAB.
NOTE: Stratasys is not responsible for radio or TV interference caused by unauthorized modification
to this equipment. Changes or modifications not expressly approved by Stratasys could void the user’s
authority to operate the equipment.

Equipment Recycling
In the European Union, this symbol indicates that when the last user wishes to discard a product, it
must be sent to appropriate facilities for recovery and recycling. For information about proper
disposal, check your purchase contract, or contact the supplier of the equipment.

Limitation of Liability
The product, software or services are being provided on an “as is” and “as available” basis. Except as
may be stated specifically in your contract, Stratasys Ltd. expressly disclaims all warranties of any
kind, whether express or implied, including, but not limited to, any implied warranties of
merchantability, fitness for a particular purpose and non infringement.
You understand and agree that Stratasys Ltd. shall not be liable for any direct, indirect, incidental,
special, consequential or exemplary damages, including but not limited to, damages for loss of profits,
goodwill, use, data or other intangible losses (even if Stratasys has been advised of the possibility of
such damages), resulting from: (i) the use or the inability to use the product or software; (ii) the cost of
procurement of substitute goods and services resulting from any products, goods, data, software,
information or services purchased; (iii) unauthorized access to or alteration of your products, software
or data; (iv) statements or conduct of any third party; (v) any other matter relating to the product,
software, or services.
The text and drawings herein are for illustration and reference only. The specifications on which they
are based are subject to change. Stratasys Ltd. may, at any time and without notice, make changes to
this document. Stratasys Ltd., for itself and on behalf of its subsidiaries, assumes no liability for
technical or editorial errors or omissions made herein, and shall not be liable for incidental,
consequential, indirect, or special damages, including, without limitation, loss of use, loss or alteration
of data, delays, or lost profits or savings arising from the use of this document.
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Using This Guide
This user guide provides instructions for installing, operating and
maintaining Stratasys 3D printing systems. It explains how to use features,
and provides practical examples to guide you as you use the system.
The text and figures in this guide are based on the 3D printer, printer
software version 85.1.0 and Objet Studio software version 9.2.
This guide assumes that—
• all the hardware, software, and network components of your Stratasys

system are installed, configured, and operating correctly.
• the operator has a working knowledge of the Windows® PC platform.

For More Information
Visit http://www.stratasys.com/ for more details about Objet printer
technology, products and consumables, and for service and support
contacts.
For other documents that relate to Stratasys P750K 3D printing systems,
and for this document in other languages, contact your regional Stratasys
Customer Support office.
If you have any questions about the information presented in this
document, or if you have any comments or suggestions for future editions,
please send a message to c support@stratasys.com.
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Terms Used in This Guide

build tray In Objet Studio: The surface displayed on the screen that
represents the actual build tray in the printer.
In the printer: The surface upon which models are produced.

cleaning fluid Cleanser for flushing material feed tubes and the printing
block, used to completely remove Model and Support
material from the system before loading another type of
material in the printer and before long term shutdown. The
cleaning fluid is supplied in standard material cartridges.

client/user workstation The workstation on which Objet software is installed, used
for preparing build trays for production on Objet printers.
(There is no limit to the number of client workstations in the
local network.)

Connex™ The technology of printing models by jetting multiple
materials simultaneously from the print heads. This
technology enables Stratasys P750K printers to print in
Digital Material mode.

Digital Material™ Combinations of model materials fabricated in the printer
from the two basic model materials installed.

Digital Material Mode The printer mode used to print a job using two different
model materials. (This mode can also be used to eliminate the
need for performing the Material Replacement procedure
when printing with a single model material.)

host/server workstation The workstation that interfaces directly with the Stratasys
printer and is typically positioned next to it.

Job Manager™ The part of Objet Studio software that manages production
jobs before they are sent to the Stratasys printer.

mixed part Models whose parts are printed using more than one model
material.

mixed tray A build tray containing objects, each of which is designed to
be printed using a different model material.

Model material Material used for building models.

Objet Studio™ The software with which users prepare jobs for producing
models.

OBJDF (Objet Digital Format) The extension of a file that contains information about the
geometry of an object and the materials required to print it.
objdf files are created in Objet Studio.

OBJTF (Objet Tray Format) The extension of a file that contains all of the information
needed for a model printing job on Objet 3D printers. An objtf
file is used to send a print job to an Objet 3D printer.
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OBJZF (Objet Z Format) The extension of a compressed “wrapper” file containing all
of the files used in an Objet Studio build tray. Using objzf files,
a printing job can be saved as a single file, for convenient
storage and transfer.

Objet™ printer The Objet 3D printer referred to in this guide.

Printer computer The computer inside the Stratasys printer that operates it.
(This is sometimes referred to as the “embedded” computer.)

Printer interface The GUI (graphical user interface) used for controlling the
Stratasys printer.

Printer software Software running on the computer inside the Stratasys
printer, that controls all printer operations.

resin The base substance from which photopolymer printing
materials are made for use in Stratasys printers. In Objet
Studio and printer application screens, “resin” refers to
cartridges of model and support materials.

SLC A file type used with Objet software. (These files are bitmaps
of individual slices of the object. For more information, see
page 3 3.)

STL A file type used with Objet software. (For more information,
see page 3 3.)

Support material Material used for supporting the structure of models during
production.
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Safety Features
Stratasys 3D printers are designed to comply with CE and FCC standards.
They are equipped with the following safety features:

Cover Interlock
Switch

The power supplied to the UV lamp and the
motion motors is turned off when the cover is
opened.
WARNING: Do not defeat (override) the
interlock switch. Doing so could result in
serious personal injury. If the interlock switch
does not function correctly, do not use the
printer, and contact your service provider.

Safety Lock The cover is locked while the printer is
working. The lock is released when the printer
reverts to pause or stop mode.
WARNING: Do not defeat (override) the
safety lock. Doing so could result in serious
personal injury.
If the safety lock does not function correctly, do
not use the printer, and contact your service
provider.

UV Screening The transparent section of the cover blocks
harmful UV radiation, allowing the operator to
view the model as it is being made.

Circuit Breaker The power to the printer is turned off in case of
electrical overcurrent.
Note: The circuit breaker is only accessible to 
service personnel.

UV Lamp
Overheating
Protection

The power supplied to the UV lamp and the
motion motors is turned off if the temperature
around the lamp reaches 90 °C (194 °F).
A label on the UV lamp cover indicates if the
temperature has exceeded 65 °C (150 °F).

Grounded Chassis The chassis of the printer is grounded, to
prevent electrical shock.
Note: The power outlet must be properly 
grounded, in accordance with the local 
electric code, to provide this protection.

UV screen

If the Stratasys 3D printing system is not used as specified in this guide, the 
safety features may not provide adequate protection.
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Symbols and Warning Labels
This following table lists the warning labels located on or in Stratasys
printers.

Warning 
Symbol

Meaning Location Comments

Hazard
(general)

On the name plate
on the back of the
printer.

Read the instructions
in this document
before operating the
printer.

Hot surface On the print head
block.

Risk of burns. Do not
touch this surface
after printing.

High voltage Near the UV lamp
connectors.
Near the power
supply enclosures.

Risk of electric shock.

Ultraviolet
radiation

Near the UV lamps. Risk of injury from
ultraviolet radiation.
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Safety Guidelines
The following general guidelines, together with the instructions provided
throughout this user guide, ensure user safety while operating and
maintaining the system. If the system is not operated as specified, the
user s safety may be compromised.

Printer
Installation

Installation and removal of the printer should only be done by qualified
service personnel.
Connect the printer (and the UPS unit) to the electric outlet using a
power cord that is safety certified.
The electric outlet should be easily accessible, near the printer.
Never connect the power plug to an outlet that does not have a ground
(earth) wire, and never disconnect the ground. Doing so might expose
the operator to serious danger from electric shock.
The following safety statement is followed by translations to Finish,
Norwegian, Swedish and Danish, as required by local regulations:
“The machine must be connected to a grounded power outlet.”

FI: Laite on liitettävä suojakoskettimilla varustettuun pistorasiaan.
NO: Apparatet må tilkoples jordet stikkontakt.
SE: Apparaten skall anslutas till jordat uttag.
DK: Apparatets stikprop skal tilsluttes en stikkontakt med jord, som
giver forbindelse til stikproppens jord.

Leave a minimum of 15 centimeters between ventilation openings and
walls or other objects.

Printer
Operation

The printer should only be operated by persons trained by a Stratasys
customer support representative.
All personnel operating or maintaining the printer should know the
location of first aid and emergency equipment and how to use it. Never
block access to this equipment.
Keep fingers and other body parts clear of the printer cover when
closing it.
Never attempt to open the printer cover while it is working.
Never override the interlock safety switch.
If the interlock safety switch ever fails, do not use the printer.
Several parts of the printer remain extremely hot even after it has
stopped operating. Avoid touching the UV lamps and the print block.

UV Radiation The UV lamps used in the printer emit dangerous radiation.
If the UV lamps remain on when the printer is open, do not stare
directly at the UV light. Shut down the printer and call your Stratasys
service provider.

Printer
Maintenance

Service operations should be performed only by qualified personnel
who have been instructed in relevant safety precautions.
Notify co workers and those who have access to the Stratasys system
before beginning non routine and hazardous work.

Report any potential dangers and safety-related accidents to your safety 
officer or to other appropriate authorities.
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Model and 
Support
Materials

Model and support materials are made of chemical substances. Although
precautions must be taken when handling these materials directly, all
model and support materials used by the Stratasys system are handled in
sealed cartridges. Normally, operators of the printer should never be
directly exposed to hazardous materials. In the unlikely event of a leak or
spill, follow the instructions that are included with the printing material
cartridge used.

Store model and support materials indoors, in a dry area with adequate
ventilation, between 16 27 degrees Celsius (60 81 degrees Fahrenheit).
Never expose them to flames, heat, sparks, or direct sunlight.
Keep model and support materials away from areas where food and
drink are stored, prepared and consumed.
Uncured printing material is considered a hazardous substance,
requiring certain precautions when directly handling it. To prevent skin
irritation, wear neoprene or nitrile gloves. If there is any chance that
model and support materials might splash into the eyes, wear safety
goggles. Prolonged direct contact with printing materials can cause an
allergic reaction.
When handling UV cured models that may not be completely cured on
the surface, common latex gloves are adequate.
To prevent respiratory irritation, ventilate areas where model and
support materials are used. If the printer is not equipped with an
exhaust duct, the room ventilation system should replace the air at least
20 times per hour.
Clean up model material and support material spills with disposable
towels or other absorbent, non reusable material, such as sawdust or
activated charcoal. Rinse the spill area with denatured or isopropyl
alcohol (IPA), followed by soap and water. Dispose of the absorbent
material in accordance with local regulations.
Do not wash contaminated clothing at home; clothing should be
professionally laundered.
Dispose of contaminated shoes, belts and other leather items in
accordance with any applicable regulations. Absorbed printing
material may re expose the user when these items are worn.

UV Lamps UV lamps used by the printer to cure printing materials contain a small
amount of mercury. In the unlikely event of lamp breakage, avoid inhaling
mercury vapor, and ventilate the room. If the lamp ruptures (breaks)
during operation, leave the room and ventilate it thoroughly (for about 30
minutes).
Use protective gloves to prevent contact with mercury and other lamp
components. Carefully remove spilled mercury with a method that
prevents the generation of mercury vapor, such as a syringe, packing tape
or paper.
Place the broken lamp, mercury and contaminated materials in an air tight,
non metallic container. Dispose of the container in accordance with
applicable regulations.
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First Aid for Working with Printing Materials
In general, try to avoid direct contact with uncured printing material. If
skin or eyes come into contact with it, wash the area immediately and
thoroughly with water, and follow these first aid instructions.

Contact with 
Skin

If uncured printing material comes in contact with skin, wash the affected
area immediately and thoroughly with soap and cool water, then remove
contaminated clothing. Pay particular attention to flushing the hair, ears,
nose and other parts of the body that are not easily cleaned.

Use cool water to prevent skin pores from opening, so that the liquid
material does not easily penetrate the skin.
Do not use solvents to clean skin.
If large areas of skin have been exposed, or if prolonged contact results
in blisters, seek medical attention. In any case, if irritation persists, seek
medical attention.
Avoid the accidental transfer of printing material from the hands to
other areas of the body, especially to the eyes.
If protective cream was used, do not reapply it until the skin has been
completely cleansed.

Contact with 
Eyes

If uncured printing material comes in contact with the eyes, flush
immediately with large amounts of water for 15 minutes and seek medical
attention.

Avoid sunlight, fluorescent light, and other sources of ultraviolet
radiation.

Wearing contact lenses when handling liquid printing materials is not
recommended. If the liquid splashes into the eyes when contact lenses are
worn, immediately remove the lenses and flush the eyes with water.

Clean and disinfect the contaminated lenses.
Do not wear contact lenses until eye irritation disappears.

Ingestion If printing material is swallowed, refer to the instructions included with the
cartridge. Seek medical attention immediately.

Inhalation Vapors from printing materials can be irritating to the respiratory system.
If respiratory irritation occurs, expose the victim to fresh air immediately.

If the victim has stopped breathing, perform artificial respiration or
cardiopulmonary resuscitation.
Seek medical attention immediately.
Keep the victim warm but not hot.
Never feed anything by mouth to an unconscious person.
Oxygen should be administered by authorized personnel only.

The Material Safety Data Sheet (MSDS) that accompanies printing 
materials contains important safety information. Keep this in an accessible 
place where these materials are used and stored.
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Waste Disposal 
Fully cured printed models can be disposed of as ordinary office trash.
However, special care is required when handling printer waste (uncured
printing material).

Printing Materials When removing the waste container from the Stratasys printer, wear
neoprene or nitrile gloves.
To prevent liquid waste from splashing into the eyes, wear safety
goggles.
Liquid waste from the Stratasys printer is classified as hazardous
industrial waste. Therefore, printing material waste must be packaged
and disposed of in a manner that prevents human contact with it and
contamination of water sources.
Empty model material and support material cartridges contain residue
of their contents. Some leakage of this residue may occur through the
broken cartridge seal. Therefore, handle and store empty cartridges
with care.
Do not attempt to reuse empty cartridges, and do not puncture them.
Dispose of used cartridges and waste containers in accordance with
local regulations.
Discard contaminated clothing, shoes, empty containers, etc., in
accordance with any applicable regulations.

UV Lamps UV lamps used by the printer to cure printing materials contain a small
amount of mercury, and are considered “Universal Waste.” Recycle or
discard used lamps in accordance with applicable regulations.
Broken lamps:
After ventilating the area, use protective gloves and carefully remove
spilled mercury with a method that prevents the generation of mercury
vapor, such as a syringe, packing tape or paper. Place the broken lamp,
mercury and contaminated materials in an air tight, non metallic container.
Dispose of the container in accordance with applicable regulations.
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Welcome to Connex
The advanced capabilities of Connex™ 3D printing systems are made
possible by technology specially developed by Stratasys for printing
models simultaneously with different model materials.
With Connex printers, you can achieve the following results when printing
3D models:
• You can prepare objects for printing with two designated model

materials and then print them at the same time. This enables you to
assign specific mechanical and color properties to objects.

• You can print parts of the same model—simultaneously—with different
materials (or material combinations).

• You can print objects that have a “coating” made from a different
material than the main part of the object.

Because Connex printers can be loaded with different materials, you can
streamline and economize the process of producing models:
• Printing models made from different materials on the same build tray

(“mixed tray”), in the same print job, eliminates the time consuming
need and expense of loading another material, flushing the system, and
sending a separate job to be printed.

Objet Studio enables you to split models into component parts (“shells”) so
you can isolate, manipulate and print parts of a model. Then, you can
assign model materials and other characteristics to the shells. However,
you have ultimate control when separating models into shells by preparing
stl files with your CAD software.
Figure 3-1: The Stratasys P750K 3D Printer

Work Configurations
The Stratasys 3D printing system can be set up as a single station system or
as a multi station system. When connected to a local computer network, the
system can serve multiple users. In such configurations, each user
workstation (client) prepares files with Objet Studio software for
production. A server (host), typically next to the 3D printer, acts as a job
manager that sends production jobs to the printer for production.
Figure 3 2 shows the printer set up in a multi client configuration.
Figure 3-2: Multi-client network configuration

When installing Objet Studio, you choose whether to install it as a client
station or as a master station (server or standalone station).
Objet Studio arranges the jobs it receives according to their priorities,
model material type, and other factors. In multi workstation
configurations, the operator of the server—typically the production
administrator—has total control over the jobs sent to the 3D printer, and
can prioritize and delete jobs, review job history and reprint a job, and so
on.
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Source Files 
Objet 3D printing systems produce three dimensional models designed
with most 3D CAD tools and with other job specific 3D applications.
Stratasys systems accept:
• STL Files
• SLC Files
Stratasys systems feature the capability of producing different types of
model files simultaneously.

STL Files STL is short for Standard Triangulation Language. This language views any
object as a collection of surfaces, and describes each surface of the object as
a collection of triangles.
For example, a square can be described as two triangles; a cube (six
squares) as 12 triangles. Curved surfaces need more triangles to describe
them. The higher the tolerance (for smooth surfaces), the more triangles are
needed. The result is that high quality object descriptions mean very heavy
files.
Most CAD software can export STL files. The Stratasys system utilizes
these files for building models (rapid prototyping), and also for directly
making molds for mass producing items.
STL files can be ASCII (text) files or binary files. The content of the ASCII
file begins with “solid” and ends with “end solid” (both lower case).
Between these keywords is a list of the triangles that describes the faces of
the solid model. Each triangle defines a single normal vector directed away
from the solid’s surface, followed by its X Y Z coordinates. These are
expressed as Cartesian coordinates and are floating point values. The
coordinates of all triangles should be positive and should fall within the
volume of the model.

SLC Files SLC is short for Stereo Lithography Contour. SLC files describe two
dimensional contours of the three dimensional models. These contour lines
are polylines.
SLC files are ASCII (text) files that save models as a series of slices. This
means that models based on SLC files cannot be orientated; only their scale
(size) and position on the build tray can be controlled. For this reason, the
model’s orientation must be suitable for production before it is saved as an
SLC file. Because of the nature of SLC files, the appearance of models in
Objet Studio may be different than the solid object images displayed from
STL files.
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Connex Workflows
With Connex 3D printing systems, you have great flexibility in preparing
model files and printing them. Below are the major workflows you can use.
Detailed instructions for implementing the listed tasks are in chapter 5
(“Using Objet Studio”).

Connex workflows, from design to finished models

Stage Workflow A Workflow B Workflow C
CAD program • Design a 3D object.

• Save it as a single stl
file.

• Design a 3D object.

• Save it as an
assembly of stl files.

• Design a 3D object.

Objet Studio • Open (Insert) the stl
file.

• Separate the object
into its components
(“shells”).

• Assign materials to
the components.

• Open (Insert) the stl
files as an assembly.

• Assign materials to
the assembly’s
components.

• Open (Insert) an
objdf file.
(objdf files contain
model material
information.)

• Save the object as an objdf file (optional).

• Save the build tray. / Send the build to the printer.
Stratasys Printer

Models are produced in the printer.

• Remove the support material from the models.
Finished model

Finished model.
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Printing Materials
Stratasys printers produce models by jetting thin layers of printing
materials on the build tray, until the complete model is formed. Two types
of material are used in this process:
• Model material—which makes up the finished model
• Support material—which fills gaps and spaces in the model during

printing, and is removed after printing

Storage Materials used for printing models with Stratasys printers are made of
resins, which are composed of reactive monomers and oligomers.
Although printing materials are supplied in sealed, UV proof cartridges,
care must be taken when storing and handling them. Follow these
guidelines to protect operators and the environment, and to ensure
optimum results.
• To ensure product stability, do not allow these materials to come into

contact with metal. Plastics made from monomer soluble substances
(such as polystyrene or polyvinyl chloride) are not suitable for storing
PolyJet printing materials.

• When not in use, keep material cartridges tightly sealed to prevent
contamination, the effects of exposure to UV radiation, and accidental
spillage.

• Store material cartridges indoors, in a dry area with adequate
ventilation, between 16–27 degrees Celsius (60–81 degrees Fahrenheit).
If exposed to heat or flames, cartridges might burst or ignite.

• Signs of premature polymerization in material cartridges include
bulging, leaking, the emission of heat, and unusual odor. Exposure to
heat can cause resin to gel in the cartridge.

• Make sure that material cartridges are stored in accordance with all
local regulations and other applicable requirements.

Shelf Life Materials used for producing models have a limited shelf life. The expiry
date on the label is valid when properly stored in an undamaged,
unopened cartridge. Always rotate your stock, so that the cartridge with
the earliest date is used first.

Exposure to 
Light

If printing materials are not in their sealed cartridges, make sure to shield
them from sunlight and other sources of UV radiation, such as fluorescent
and mercury vapor lights. Exposure to UV radiation causes an increase in
viscosity and, eventually, solidification.

For up-to-date information about PolyJet printing materials and their 
properties, go to http://www.stratasys.com/materials/polyjet.
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Safety 
Considerations

Before being cured, resins are hazardous materials. To prevent possible
health hazards, follow these precautions regarding printing materials:
• Do not expose to flames, heat or sparks.
• Prevent contact with skin and eyes.
• Ventilate areas where they are handled.
• Keep them separate from food and drink.
Cured plastic parts, however, are safe. They can be handled and stored
without precautions.

Disposal Dispose of cartridges of model and support material in accordance with all
applicable laws and regulations. If necessary, the cartridges can be
disassembled for recycling.

Work Environment
Extreme heat and humidity conditions can adversely affect the operation of
the Stratasys 3D printer. Use ventilation or air conditioning systems, if
necessary, to keep the work area within the following ranges:
• 18 –25 C (64 –77 F)
• 30%–70% relative humidity

You can find more safety information about resins in “Safety Guidelines” on 
page 2-4, and “First Aid for Working with Printing Materials” on page 2-6.
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Workstation Requirements 
The table below lists the requirements for computer components on
workstations running Objet Studio.
Important: Make sure that the server workstation is set up with
Administrator privileges.

Requirement

Computer Type Server workstation: Standard desktop PC1

Processor Intel® Core™ i3 or better

Operating System Windows® 7 or Windows® 8, 64-bit2

RAM 8 GB or more2

Graphics Card3
Open GL®

Memory: 1 GB; 2 GB recommended for dental applications

For server workstation: VGA connector4

Optical Drive CD/DVD ROM

Hard-Disk Drive 80 GB or larger (minimum free space: 40 GB)

Network Card LAN TCP/IP 
(2 for server workstation; 1 for client workstation)

Mouse/Keyboard 
Connection Server workstation: USB1

Monitor Cable VGA connector1

1. For systems using a KVM switchbox to control both the built in
printer computer and the server workstation with same keyboard
monitor mouse set: All in one computer, wireless mouse and
wireless keyboard cannot be used.

2. A 64 bit operating system is recommended, to utilize 8 GB of
memory. Objet Studio running on a 32 bit application can utilize
only 4 GB of memory.

3. The following graphics cards were tested in Stratasys labs:
• NVIDIA® Quadro® Family—FX570, FX1700
• NVIDIA® GeForce® Family—6200 TurboCache™, 7300 GT, GTX 285
• Intel® Express Chipset—82915G/GV, 82910GL, Q965, Q963, Q35, Q45, Q43,

82852, 82855
• ATI Radeon™ HD 5670, HD 5970
• AMD Radeon™ E6760

4. For systems using a KVM switchbox. If the server workstation has
a DVI video connector, a VGA adapter is needed.
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Preparing Files for Use with Objet 3D Printing Systems
Before using files with Stratasys 3D printing systems, you need to convert
them in your CAD program to a file format supported by Objet Studio. (For
an explanation of these file formats, see “Source Files” on page 3.)

Converting 
CAD Files to 
STL Format

This procedure may vary slightly, depending on the CAD software used,
but the following instructions generally apply.

To convert a file to STL format (in a CAD program):
1. From the File menu, select Save As.
2. In the Save As dialog box, open the Save As Type drop down list and

select *.STL.
3. Click Options and set the following parameters:

• Total Quality—approximately 0.01 mm (deviation tolerance /
linear dimension tolerance)

• Detail Quality—approximately 5° (angle tolerance)
Note: Lowering these values produces more accurate models, but 
results in larger files and longer loading and processing times. For this 
reason, it is generally not recommended that you use lower values.

4. In the file format option, choose binary or ASCII. (Both binary and
ASCII formats can be used in Objet Studio. However, binary files are
smaller, so this option is recommended.)

5. Click OK or Save.
After converting the model files, it is recommended that you check them for
defects in an STL repair application (such as Magics™, by Materialise®)
before opening them in Objet Studio and producing the model.

Converting 
CAD Files to 
SLC Format

When converting files to SLC format, it is recommended that you set a layer
thickness of 15 microns (0.015 mm). Since SLC files cannot be orientated in
Objet Studio, it is important that models are properly orientated before
being saved as SLC files. Considerations for suitable model orientation are
explained in “Model Orientation” on page 5 26.

For more information, search for “CAD to STL” on www.stratasys.com.
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Objet Studio Software
Objet Studio software for the Stratasys 3D printing system consists of two
main screens:
• Tray Settings / Model Settings
• Job Manager

Tray Settings / Model Settings
In the Tray Settings and Model Settings screens, you prepare source files for
production in Stratasys 3D printers. Objet Studio offers you a wide variety
of file preparation options, but always consists of the following basic
procedure:
1. Inserting one or more objects on the build tray
2. Positioning the object(s) on the tray
3. Configuring object and tray parameters
4. Saving the tray configuration as an objtf (Objet Tray Format) file
5. Sending the objtf file to the Stratasys 3D printer for production
Using Objet Studio to perform these tasks is described in detail in chapter 5,
“Using Objet Studio.”

Job Manager
The Job Manager screen is different for client workstations and for the
computer connected directly to the Stratasys 3D printer.
• In Objet Studio installed on the directly connected computer (server),

the Job Manager screen displays the queue and status for all jobs sent to
the 3D printer by the server itself and by all client computers on the
network. All jobs displayed can be edited and manipulated.

• In Objet Studio installed on client computers, the Job Manager screen
displays the queue and status only for jobs sent to a 3D printer server
from that computer. Only these jobs can be edited and manipulated
from the client computer.

Client computers can be connected, via the local network, to different Objet 
3D printers, but only to one at a time. The Job Manager screen displays the 
status of the 3D printer to which the client is currently connected.
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How to Install Software for the Stratasys 3D Printing System
The Objet Studio setup wizard guides you when installing this software.
Objet Studio is installed on the printer server (“host”) computer, but it can
also be installed on remote, “client” computers and on computers used to
prepare files for printing models, or for training and demonstration
purposes. During installation, you choose to install either the printer server
(“host”) application or the client application.

To install Objet software:
1. Insert the Objet Studio CD into the disk drive.
2. Right click the Start button and select Explore (or use any other method

for displaying files on the computer).
3. Open the CD drive folder and select Setup.
4. If you are installing an Objet Studio upgrade, make sure that your

printer is compatible with it by checking the list displayed.

Figure 4-1:Objet Studio compatibility check

5. To install Objet Studio, you must agree to the license agreement. After
reading its terms, click Yes to continue, or No to close the wizard.
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If you click Yes, the following screen should appear.

Figure 4-2: Objet Studio installation wizard—Welcome screen

6. Click Next to begin installation.
7. In the Select Features screen, select the required installation option.

Select Objet Studio for a server computer...
• if you are installing Objet Studio on the server (“host”) computer—

the computer directly connected to an Stratasys printer.
• if you are installing Objet Studio on a standalone (off line)

computer.
Select Objet Studio for client workstations if you are installing Objet
Studio on a “client” workstation—a remote computer that prepares
print jobs and then sends them to a server computer.

Figure 4-3: Objet Studio configuration selection
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8. In the Select Installation Folder screen, verify the destination folder and
click Next.

Figure 4-4: Objet Studio installation-folder selection

9. In the Confirm Installation screen, click Next to begin installation.
10. In the Select Printer Type screen, select the Objet 3D printer used for

producing models and click Next.

Figure 4-5: Printer selection

It is recommended that you do not change the default destination folder.

Click Disk Space to check the space in the destination folder.
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Installation begins and a progress bar appears, showing the progress of
the installation process.

Figure 4-6: Installation progress bar

When the Objet program installation is complete, the final InstallShield
wizard screen appears.

Figure 4-7: Final installation screen

11. Restart the computer to complete the software installation.

Note: If you installed the software from a CD or DVD, make sure to remove 
it from the disk drive before restarting the computer.

The installation process ends when the appropriate icon(s) appear on the
computer desktop:
• Objet Studio
• Stop Job Manager (for servers and standalone stations)
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How to Uninstall Objet Studio
If there is ever a need to uninstall the Objet Studio software, do not attempt
to do so from the Windows Control Panel. (This does not completely
remove all software components.) Instead—

From the Start menu, select All Programs > Objet Studio > Uninstall Objet 
Studio.
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Launching Objet Studio
After you install Objet Studio, a launch icon appears on the
Windows desktop. Open the application by double clicking this icon, or by
selecting Objet Studio from the Start menu.

Windows® 7 
Security 
Warning

Depending on the User Account Control settings in Windows® 7, you
might see the following warning when opening Objet Studio.

Figure 5-1: Security Warning

If you click Yes, Objet Studio opens. However, this warning message will
appear each time you open the program, unless you change the User
Account Control settings.

To prevent the warning message from appearing again:
1. Click the link at the bottom of the security warning dialog box (Change 

when these notifications appear).
2. In the User Account Control Settings screen, move the slider to “Never

notify.”

Figure 5-2: Changing the User Account Control settings

3. Click OK.
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4. In the following dialog box, click Yes.

Figure 5-3: Confirming the change in the User Account Control settings

Objet Studio 
Interface

When Objet Studio opens, the Tray Settings screen appears, showing an
empty build tray.
Figure 5-4: Objet Studio opening screen

The Objet Studio interface consists of two main screens:
• Tray Settings—for arranging models and preparing them for printing.
• Job Manager—for monitoring and managing print jobs.

This screen is described in “Monitoring and Managing Print Jobs” on
page 68.

Each screen is controlled by menus and icons on its own ribbon. An
additional ribbon, Model Settings, displays controls for configuring and
manipulating selected models.
Objet Studio anticipates your workflow by displaying and enabling the
options relevant to your current task. For example, when you first open
Objet Studio, the Model Settings ribbon is disabled until you place a model
on the build tray. Similarly, options available from the standard toolbar
menus are enabled or disabled to match the current workflow.
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The ribbon, colors used, and several other interface features can be
customized. How to change the appearance of the interface is explained in
“Customizing Objet Studio” on page 57.

Figure 5-5: Tray Settings ribbon

Figure 5-6: Model Settings ribbon

Instructions for using the commands for preparing models for production 
and sending jobs to the printer, appear later in this chapter. 
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Ribbon
Commands

The following table lists the Tray Settings and Model Settings ribbon
command groups, and shows when they are enabled, and where they
appear.

Group Purpose When 
enabled 

 Tray 
Settings 
Ribbon

Model 
Settings 
Ribbon

Setting display
colors.

Always.

Selecting
perspective and
zoom level.

Models are on
the build tray.

Choose to select
a plane,
elements, or
element groups
(assemblies).

Models are on
the build tray.

Change the
perspective of
the active pane.

Models are on
the build tray.

Assigning
printing
material(s).

• Build tray
is empty.

• Models are
not
selected.

Undoing or
redoing actions.

After an
action or
object
selection.

Opening and
saving files.

Models are
not selected.
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Placing model
files on the build
tray.

Always.

Pre build/build
commands.

Models are on
the build tray.

Setting model
dimensions.

A model is
selected.

Cutting,
copying, pasting
and deleting
models.

A model is
selected.

Moving, rotating
and resizing
models.

A model is
selected.

• Assigning a
material to a
model or
shell.

• Separating a
model into
shells.

A model is
selected.

Assigningmodel
finish and
setting support
strength/
“hollow.”

A model is
selected.

Setting a model’s
unit of measure
(millimeters or
inches).

A model is
selected.

Group Purpose When 
enabled 

 Tray 
Settings 
Ribbon

Model 
Settings 
Ribbon

To quickly identify an icon, move the cursor over it to display a tooltip. The 
“Undo” and “Redo” tooltips change to reflect your last Objet Studio action.

After activating some of the ribbon commands (by clicking them), they remain 
active until you click another button or until you press the Escape key.
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Objet Studio 
Commands
Menu

Clicking the icon in the upper left corner opens the Objet Studio
Commands menu. This menu displays basic application commands and
options.

Figure 5-7: Objet Studio Commands menu

The Options button opens a dialog box for customizing Objet Studio.

Figure 5-8: Options dialog box

Model Tree 
Pane

The Model Tree pane lists the objects placed on the build tray in a parent
child hierarchy. By default, the pane “floats”— that is, you can move it to
another position on the screen and resize it. Alternatively, you can fix its
position at the left of the application window, and even hide it.
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Preparing Models for Production
Model preparation involves the following basic steps:
1. Place objects or assemblies on the build tray.
2. If necessary, manipulate the object’s orientation and position.
3. Select the materials and model finish.
Just as Stratasys printers can produce different models on the build tray
using different materials, you can produce components of a model with
different materials. To do this, each part of the model must be a separate stl
file. If the model’s component parts were not saved in the CAD software as
separate stl files, you can use Objet Studio to separate the model into
component parts. (This is described in “Splitting Objects into Components”
on page 19 and in “Dividing Objects” on page 51.)

OBJDF Files: 
Overview

An objdf file describes both the geometry of a single object and the
materials, and finish required to print it. The objdf file can represent an
object that is a single stl file, or an object assembled from component stl
files.
Objet Studio enables you to split an stl file representing a complex object
into an assembly of component stl files, and save the assembly as an objdf
file. Each part (stl file) described by the objdf file can have its own model
material characteristic, so that the Stratasys printer produces the
component parts from specific materials.
Another use for objdf files is for saving a group of separate objects on the
build tray as one unit, together with their relative positions and materials.
This is especially useful for producing models in the future with the same
materials. In fact, when you save objdf files, you specify materials for
printing models without regard to the material cartridges loaded in the
printer. The same object can later be placed on build trays for printing. Each
time you send a build tray to the printer, you decide whether to allow
printing with substitute materials or only with the materials specified.
The Connex version of Objet Studio enables you to display, manipulate and
print component parts of a model assembly that was saved as an objdf file,
since each component is a separate stl file. This can be useful for printing
only specific parts of a model.
Further explanations of objdf files, and their features, appear throughout
this chapter.

Model Files To produce models, you open one or more model files in Objet Studio and
position objects on the build tray. You can place objects on the build tray in
several ways:
• by inserting individual stl or slc files (or an assembly of stl files).
• by inserting an objdf file (an assembly).
• by pasting objects that you copied to the Windows clipboard.
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Placing
Objects on the 
Build Tray

To place an object on the build tray:
1. Open the Insert dialog box—

• From the Object menu, select Insert.
or—
• On the Tray Settings ribbon, click .
or—
• Right click on the build tray, and select Insert from the context

menu.
The Insert dialog box appears.

Figure 5-9: Insert dialog box

2. In the Look in field, display the appropriate folder.
3. In the Files of type field, select the file type to display.
4. Select the desired file, and make sure that it appears in the File name

field.
If the Preview check box is selected, the object is displayed in the dialog
box, as shown in figure 5 9.
You can open several stl files to place several models on the build tray.
If you select multiple stl files that make up an assembly, you can select
all or some of the parts. To print the entire model, select all of an
assembly’s component stl files, and select the Assembly check box. This
positions the parts as a complete, integrated model instead of as
independent parts. The effects of selecting the Assembly check box—in
both the model tree and the build tray display—are shown in the
following figures.
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Figure 5-10: Assembly check box selected—stl files are placed as an assembly

Figure 5-11: Assembly check box not selected—stl files are placed as parts

The Model Settings ribbon is displayed when objects are placed on the
build tray.

5. Select any of the following options, as required:
• Units—Millimeters or inches for the object’s units of measure.

The 3D file contains the object s proportions, but not its units of
measure. Therefore, make sure to correctly select either millimeters
or inches when inserting an object. Otherwise, the size of the object
on the build tray will be either much too large or much too small. To
change the measurement units of objects already placed on the tray,
see “Measurement Units” on page 31.

• Number of copies—How many copies of this object to place on the
build tray.

• Orient Automatically—Automatically orient objects on the build tray
for efficient model building.

• Assembly—Mark this check box if you selected multiple stl files that
are part of an assembly.
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Note: The Extents values displayed in the Coordinates section of the Insert
dialog box, represent the maximum dimensions of the object on each 
axis. These dimensions correspond to the virtual “bounding box” 
surrounding the object see figure 5-50 on page 38). 

6. Click Insert.
Objet Studio places the object on the build tray, and in the model tree.

Figure 5-12: Default screen layout

The Model Settings ribbon is displayed when objects are placed on the
build tray.
If the object is over a certain size, the Loading Placed Elements dialog box
appears.

Figure 5-13: Loading Placed Elements dialog box

Model 
Toolbar

Model
Tree 
pane

You can speed up the opening of large files by changing the Large Files
settings—see “Loading Large Files” on page 41).
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Opening objdf Files
Before placing objdf files on the build tray, Objet Studio must extract the
component stl files together with information about their relative position
and model materials. To do this, Objet Studio creates a folder with the same
name as the objdf file, in the same location.

Figure 5-14: Insert dialog box (objdf file)
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Opening Objet 
Tray Files

You can open trays that were saved as objtf files. This is useful, for example,
if you saved a tray after preparing it for printing, and now you want to
make changes before printing it.

To place an object saved as an Objet Tray File (objtf) file on the build 
tray:
1. From the File group, click .

or—
From the Objet Studio Commands menu , select Open.
The Open dialog box is displayed.

Figure 5-15: Objet Tray File Open dialog box

2. Select the desired file, and make sure that it appears in the File name
field.
If the Preview check box is selected, the object is displayed.

3. Click Open.
Objet Studio opens the tray file.

The objtf file is actually a file containing instructions for printing—which stl
files to print and their position on the build tray. Because the objtf file 
references the stl files used, they must remain in the same file location as 
when the objtf file was saved.
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STL file loading
preference

If there are identically named stl files in more than one location, you need
to ensure that the correct component stl files are linked to the objtf file. For
example, if there are identically named stl files on one drive and on a flash
drive (this can occur if you copy the original files to a working folder), you
can set the default location from which files are loaded.

To set the Load Order:
1. From the Tools menu, select Options.

or—
In the Objet Studio Commands menu , click Options.

2. In the Options dialog box, display the Settings tab.

Figure 5-16: Options dialog box, Settings tab

3. Under Load Search Order, select an option:
• Local—to load files from the location where they were last saved.
• Original—to load files in their original location.

4. Click OK.
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Quick-Access 
Model
Commands

You can access common commands for working with objects on the build
tray with the convenient Model Toolbar and context menus.

Model Toolbar Select an object in the tray to display the Model Toolbar that contains icons
to perform common tasks.

Figure 5-17: Model Toolbar

The table below describes the Model Toolbar icons.

Right-click model
menu

If you right click on an object, a pop up context menu is displayed from
which you can also select the model finish, change its position and scale,
and set the Grid Style and Hollow options.

Icon Description

Applies a matte finish to the model.

Applies a glossy finish to the model.

Opens the Advanced Properties dialog box for setting the
Grid Style and the Hollow option.

Enables dragging an object (see page 5 32).

Opens the Transform dialog box for changing the
object’s position and scale.

Toggles the Lock Model Orientation setting.

Allows you to choose the printing materials.

Enables you to apply a coating to the model, or change
the coating previously applied.

You can also create a Quick Access toolbar with your most commonly used 
icons grouped together. See “Creating a Quick Access Toolbar” on page 57.
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Copying and 
Pasting 
Objects

If you need to duplicate objects on the build tray, you can insert the same
object from its file more than once. An easier way, however, is to copy and
paste the object. You can copy objects from the build tray or the model
tree—individual or multiple parts or assemblies. The objects copied remain
in the Windows clipboard until you paste them onto the build tray.
You can also copy objects from one tray and paste them onto another, in the
same way as you copy text from one document and paste it into another
one. However, Objet Studio allows only one tray to be open at a time. For
each build tray you need to work with (at the same time), you must open a
separate Objet Studio window, by running the application again (from the
Windows Start menu).

You perform the Copy and Paste commands as in other Windows
applications:
• from the right click context menu.
• by using keyboard shortcuts (Ctrl+C and Ctrl+V, respectively).
The Paste Special command (from the object’s right click context menu)
enables you to place duplicate objects even more efficiently:
• You can specify the number of duplicates to place on the build tray at

once.
• You can set the distance, on each axis, between the duplicate objects.
• You can manipulate mirror images of the original object, and flip them

on selected axes.

Figure 5-18: Paste Special dialog box

Having multiple Objet Studio windows open can be convenient when you 
need to manipulate or configure objects before inserting them in your 
production build tray. For example, if you need to change the model material 
of an object (saved as an objdf file) to match the model material already 
used in the production build tray, you must do so before inserting the 
object—on another tray. Copying and pasting also allows you to use objects 
already configured on previously-used build trays for newer projects.
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Selecting 
Objects

To manipulate an object on the build tray or assign characteristics to it
(model material, building style etc.), you must first select the object. You
select an object by clicking it, either on the tray or in the model tree. Its
image on the build tray changes color (to light blue, by default) and its
name is highlighted in the model tree. You can select multiple objects by
drawing a box around them with the mouse cursor, or by pressing the Ctrl
or Shift keys while clicking additional objects.
Alternatively, select or de select objects using the following Edit menu
commands:
• Select All
• Invert Selection
• Undo Select object

Figure 5-19: Edit menu

Sometimes, you need to select individual elements of an assembly. Other
times, you need to select the entire assembly. The Selection icon displayed
on the ribbon determines what will be selected when you click on the
model:

or

To change the selection action:
1. On the Tray Settings or Model Settings ribbon—

a. Click the Selection icon: or .
b. On the flyout toolbar, click the appropriate icon:

Figure 5-20: Selection flyout toolbar

Select Group

Select Element
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Splitting 
Objects into 
Components

You can convert a complex object to an assembly of component parts. To do
so, you split the stl file that represents the object into a group of separate stl
files, each one representing a component. (This is referred to in the Objet
Studio interface as separating the object into shells.) You can then assign a
model material to each stl file, and you can save the newly created
assembly as an objdf file.

To split an object into an assembly of component parts:
1. If the object is not displayed, place it on the build tray by inserting its stl

file (see “Placing Objects on the Build Tray” on page 10).
The object appears—on the build tray and in the model tree pane—as a
single part. It is assigned, by default, the “primary” model material. (If
Objet Studio is configured with a secondary material, you can assign
it—or a digital material—to the entire object. This is explained in
“Model Material Settings” on page 20.)

Figure 5-21: Object placed on the build tray from a single stl file

Note: There is no need to resize or arrange the object on the build tray at 
this time.

2. With the object selected:
• From the Object menu, select Separate into Shells.

or—
• On the ribbon, click .
A dialog box opens in which you can specify where to save the
component stl files. (By default, Objet Studio offers to save the new files
in a folder in the same location as the original stl file.)

Figure 5-22: Folder selection for saving stl files after splitting into shells

3. Click OK.
Objet Studio splits the object into an assembly of component parts, each
a separate stl file (“shell”).



Using Objet Studio

5–20 DOC08010 Rev. A (DRAFT 1)

The object appears—on the build tray and in the model tree—as an
assembly of parts (“shells”). You can assign each part a different model
material (This is explained in “Model Material Settings” on page 20).

Figure 5-23: Object after being converted to an assembly of component parts

Model-Material
Settings

Before placing objects on the build tray in Objet Studio, you should pay
attention to the material selection settings on the Tray Settings ribbon.
Figure 5-24: Material selection settings

• By default, the material selection settings on the ribbon correspond to
the model cartridges loaded in the printer.

• The material displayed on the top (VeroBlack, in the figure above) is
considered the primary model material (“Model 1”). It is assigned to
objects that do not have a material assignment when you place them on
the build tray. For example, since stl files do not contain information
about the model material, Objet Studio assigns the primary model
material to them. Also, if you try to insert objdf files whose assigned
materials are not recognized by your version of Objet Studio, you can
insert the file by substituting the primary model material for the
missing materials.

• Select Single Material if you want to print using only one material— of
the material drop down menus contain the same material. If you decide
to print with multiple materials, the material in the top drop down
menu remains assigned to the object until you select another material.

• If you insert an objdf file into an empty build tray, and the model
material assignment does not match the settings on the Tray Settings
ribbon, these settings are changed automatically. However, if there is an
object already on the build tray whose materials do not match the
material assignment in the objdf file, you cannot place the new object on
the tray. To print this object, you have the following options:

Instead of printing it on the same build tray, print the new object as a
separate job.
Change the materials assigned to objects on the build tray to match
those assigned to the new object (see “Changing the Model
Material” and “Assigning a Model Material to Objects,” below).
Change the materials assigned to the new object before inserting it,
so there is no conflict with the settings on the Tray Settings ribbon.

To change the materials assigned to an object before inserting it:
1. Open another Objet Studio window, by running the application from

the Windows Start menu.
2. Insert the new object (objdf file) into the empty build tray.
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3. Change the material selection settings on the Tray Settings ribbon to
those used on the other build tray.

4. Assign materials to the object (see “Assigning a Model Material to
Objects” on page 22).

5. Select the object and copy it.
6. Display the other Objet Studio window, and paste the object onto the

build tray.

Note: You can save the object with the new materials either as a new objdf
file, or by saving the original file with the changes.

Changing the 
Model Material

When you design a build tray in Objet Studio, you can use model materials
that might not be currently installed in the printer. Because the installed
materials are displayed by default, change the material selection settings on
the Tray Settings ribbon, if necessary.
Figure 5-25: Selecting a new model material 
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Assigning a 
Model Material 
to Objects

You can assign any of the available to objects on the build tray.

To assign a model material to objects:
1. Select an object on the build tray (see “Selecting Objects” on page 18).

When an object is selected, its properties—including model materials—
are displayed on the Model Toolbar and on the ribbon.

Figure 5-26: Object properties, on ribbon and Model Toolbar

2. Display the material drop down list and select the desired material.
Figure 5-27: Menu for assigning materials to objects

When you de select the object on the build tray, it is displayed, by
default, with the color of the material you selected. In the same way,
you can assign model materials to each of the independent objects on
the build tray.

Ribbon

Model Toolbar 

To separate an object into independent, component parts (each an stl file), 
see “Splitting Objects into Components” on page 19.
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Surface Finish Models can be printed with a matte or glossy surface finish. To create a
matte finish, the printer surrounds models with a thin layer of support
material.

To set the model finish:
1. Select the model.
2. Select Matte or Glossy in one of the following places:

• Model Settings ribbon, Options group
• Model Toolbar
• right click context menu (when selecting the model)

You can configure Objet Studio to distinguish between objects’ surface
finish on the build tray by color. To configure how Objet Studio displays
objects, see “Setting Object Colors” on page 41.

Coating
Objects

You can print composite models where the surface layer is a different
material than the inside. This can be useful to achieve unique mechanical
and textural characteristics. This technique is called “coating.”

To coat an object with a different model material:
1. Select an object on the build tray.
2. On the Model Toolbar or the Model Settings ribbon, click .

The Coat with dialog box opens.
3. Select Coat With and, from the drop down list, select the coating

material.

Figure 5-28: Coating material selected

4. In the Thickness field, enter a coating thickness between 0.3 and 3
millimeters.

Note: The coating thickness does not affect the external dimensions of the 
object, which remain unchanged. The coating layer replaces part of 
the main model material.

5. Click Apply.

Note: When you de-select objects, they are displayed, by default, with 
colors representing the model-material. Even after adding a coating 
to an object, its color remains that of the main material, not the color 
of the coating material.
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To inspect, modify or remove the coating applied to an object:
1. On the Model Toolbar or the Model Settings ribbon, click .

The Coat with dialog box opens.
2. Perform one of the following actions—

• Change the coating settings, and click Apply.
• To remove the coating, clear the Coat With check box and click Apply.
• To keep the current coating settings, click Apply or Cancel.

Assigning
Properties to 
Hidden
Objects

To enable you to assign materials and other properties to parts of objects
that are hidden from view on the build tray display, you can temporarily
turn off the display of some objects.

To prevent the display of objects:
1. Right click an object, either on the build tray or in the model tree.
2. From the menu that opens, select one of the following options—

• Hide, to cause the selected object to disappear.
• Hide Others, to cause all other objects on the build tray to disappear,

so that only the selected object is displayed.
Alternately, you can clear the check box next to the name of the
object in the model tree to cause that object to disappear.

Figure 5-29: All objects displayed Figure 5-30: Outer object hidden
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Positioning Objects on the Build Tray
To produce models efficiently and with the required finish, it is important
to carefully position objects on the build tray. Objet Studio supports the
automatic positioning of objects. However, you should check to make sure
that the objects are orientated optimally for your needs, according to the
considerations explained in “Model Orientation” on page 26.
Two things that affect the positioning of objects on the build tray are
orientation and placement. You can let Objet Studio determine the optimum
orientation and position, or you can control them.

Automatic 
Orientation

By default, Objet Studio automatically orients objects, when placed on the
build tray, for the shortest printing time. (You can later change the
orientation manually.) However, you can cancel automatic orientation
when placing an object on the build tray.

To place an object on the build tray without automatic orientation:
In the Insert dialog box, make sure Orient Automatically is not selected.

Figure 5-31: Orient Automatically option disabled

You can change the default setting, so that automatic orientation is not
applied unless you select the Orient Automatically check box each time you 
place an object on the build tray. To do this, see “Default Settings” on 
page 63.
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Automatic 
Placement

After placing several objects on the build tray, you can let Objet Studio
arrange them before printing. This ensures that the objects are positioned
properly, and that they will be printed in the shortest time and with a
minimum of material.

To automatically arrange objects on the build tray:

On the Tray Settings ribbon, click .
or—
From the Tools menu, select Automatic Placement.

The effects of automatic positioning are shown in the figures below.
Figure 5-32: Tray before objects are properly arranged

Figure 5-33: Tray arrangement after applying Automatic Placement

Manual
Positioning

You can change the position of objects on the build tray—even if they were
inserted with the Orient Automatically option. Considerations for
positioning objects are presented in “Model Orientation,” below. Tools for
changing the position of objects are presented in “Manipulating Objects on
the Build Tray” on page 27.

Model Orientation
The orientation of models on the build tray affects how quickly and
efficiently they will be produced by the 3D printer, where and how much
support material is used, and whether or not model parts will have a glossy
finish. Therefore, you should consider a variety of factors when deciding
how to place models on the tray, using the following positioning rules.

X-Y-Z Rule
This rule considers a model s outer dimensions.

Since the print heads move back and forth along the X axis, the printing
time along this axis is relatively short, compared to printing time along
the Y axis and Z axis. From this point of view, it is advisable to place the
object s largest dimension along the X axis.
Any surfaces that come into contact with support materials become
matte.
Since models are built up, on the Z axis, in 16 or 30 micron layers
(according to the printing mode), it is very time consuming to print a
tall object. From this point of view, it is advisable to place the object s
smallest dimension along the Z axis.
Since the print heads measure about 2 inches (5 centimeters) on the
Y axis, models measuring less than this (on the Y axis) are printed in
one pass. From this point of view, it is advisable to place the object s
intermediate dimension along the Y axis.

For best results, arrange the tray with Automatic Placement, on the Tray
Settings ribbon, even if you inserted the objects with the Orient
Automatically option.
The physical characteristics of each type of Model material you use can 
affect the positioning of objects on the tray. Therefore, select materials 
before running Automatic Placement.
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Tall-Left Rule
This rule considers models where, after being orientated on the build tray
according to other considerations, one side is taller than the other.

Since the print heads move along the X axis from left to right, taller
sections on the right require the print heads to scan unnecessarily from
the left until reaching them. If, on the other hand, the taller sections are
positioned on the left of the tray, the print heads only have to scan the
model until printing these sections—once the lower parts have been
completed. Therefore, you should position the taller side of the model,
when possible, on the left.

Recess-Up Rule
This rule considers models containing surface recesses.

Recesses in the surface (like hollows, drill holes, etc.) should, when
possible, be positioned face up.

Fine-Surface Rule
This rule considers models that have one side on which there are fine
details (like the keypad side of a telephone).

The side of the model containing fine details should, when possible, be
positioned face up. This results in a smooth finish.

Avoid Support-Material Rule
This rule considers models that have large holes or hollows, open on at
least one side (like a pipe or a container).

It may be advantageous to print a model standing up, so support
material does not fill the hollow, even though printing the model lying
down would be much faster.

Manipulating Objects on the Build Tray
Positioning 
Objects on the 
Z-Axis

When you use the automatic positioning option to arrange objects on the
build tray (see “Automatic Orientation” on page 25), the objects are
positioned directly on the tray. If you do not insert objects with automatic
positioning, they often appear either above or below the tray.

To position objects directly on the tray: 
1. Select the object.
2. From the Object menu, select Lay On.

The following rules are based on the fact that support material is not 
required on the top of the printed model.

In practice, the Stratasys system prints all models on the build tray on a one-
millimeter bed of support material. The importance of positioning objects 
directly on the build tray with Objet Studio is to correctly display the objects 
on the screen.
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To ensure that objects are always positioned directly on the tray:
1. From the Tools menu, select Options, and display the Settings tab.

Figure 5-34: Options dialog box, Settings tab

2. In the Automatic Lay On (Gravity) section, select Always.

Other Z-axis options (in the Automatic Lay On section):
• When under the tray—The display of objects that are below the build

tray is automatically changed so that the object is at tray level.
• Never—The display of objects that are above or below the build tray is

not changed.

Valid Object 
Placement

You can ensure that models do not overlap when you position them on the
build tray, and that they do not extend beyond the tray.

To ensure valid object placement: 
1. From the Tools menu, select Constraints Settings.

Figure 5-35: Constraints Settings dialog box
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2. Select Dynamic check to identify—
• invalid object placement while placing objects—On Drop selected.
• invalid object placement after moving objects—While Drag selected.
• objects placed beyond the tray’s boundaries—Outside Tray selected.
• objects that overlap—Object Collision selected.

Note: Because of the unique characteristics of each type of model material 
and finish, always check valid placement after changing the material/
finish. Remember that Objet Studio calculates the space occupied by 
an object including the “bounding box” surrounding it (see 
figure 5-50 on page 38).

Even if you do not use Dynamic Check when placing objects on the build 
tray, Objet Studio automatically checks if there is a problem with the 
positioning of objects on the tray before sending it to the printer. You can 
also manually check for problems after positioning objects (see “Tray 
Validation” on page 45).
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Using a Grid to 
Position 
Objects

Displaying a grid on the image of the build tray can be useful when
positioning objects. To use the grid features, select the following menu
options.

You can review and configure grid settings—and apply them—from the
Options dialog box.

To view and change grid settings:
1. From the Tools menu, select Options, and display the Grid tab.

The current grid settings are displayed.

Figure 5-36: Options dialog box, Grid tab

2. As required, change the settings, and select or clear the check boxes.
3. Click Apply or OK.

Menu Option Result

Tools > Grid Displays a grid on the build tray.

Tools > Snap to grid When moving the object, it aligns with the nearest
grid line.

Tools > Options >
Grid

Enables you to change the grid origin
(X and Y axis meeting point) and appearance.
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Measurement 
Units

3D files contain an object s proportions, but not its units of measure.
Therefore, make sure to correctly select either millimeters or inches when
inserting an object. Otherwise, the size of the object on the build tray will be
either much too large or much too small.

To set the measurement units when inserting an object:
In the Insert dialog box, Units field, select Millimeter or Inch:

Figure 5-37: Units field in the Insert dialog box

To change measurement units for a selected object from the 
Model Settings ribbon:
1. Open the Units flyout toolbar.

Figure 5-38: Units flyout toolbar

2. Select the measurement units desired.

To change measurement units for a selected object from the standard 
toolbar:
1. From the Object menu, select Change Units.

Figure 5-39: Model Units dialog box

2. In the Model Units dialog box, change the setting and click OK.
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Setting Model 
Dimensions

You can change an object’s dimensions by changing its size on the X , Y ,
and Z axes, from the Dimensions group on the Model Settings ribbon.

Figure 5-40: Dimensions on the Model Settings ribbon

• If Uniform Scale is enabled, changing the object’s dimension on one axis
affects the other dimensions, proportionately.

• After changing a measurement, press Enter or click in another field in
the Dimensions group.

Note: You can change the height of the objects on the build tray only if this 
is allowed by the Objet Studio settings (see “Positioning Objects on 
the Z-Axis” on page 27).

Repositioning 
Objects

You can manually move and rotate an object on the build tray with the
arrow keys, or by dragging it with the mouse.

To manually manipulate an object:
1. Select an object by clicking it on the build tray, or in the model tree

pane.

2. Click on the Model Toolbar, or on the Model Settings ribbon.
A frame appears around the object, and the cursor changes to indicate
that the object can be moved.

Figure 5-41: Manually moving an object
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3. If you click on a corner of the frame, the cursor changes to indicate that
the object can be rotated.

Figure 5-42: Manually rotating an object

4. Manipulate the object with the arrow keys or with the mouse.
Using the Transform

Dialog Box
You can make precise changes to an object by changing the properties in the
Transform dialog box.

To access the Transform dialog box (when an object is selected):
• Click on the Model Toolbar or on the Model Settings ribbon.
• From the right click context menu, select Transform.
• From the Object menu, select Transform.

Figure 5-43: Transform dialog box

To change an object with the Transform dialog box:
Change any of the values, then click Apply to see how the object changes
on the build tray.
Note: The changed values remain in the dialog box after clicking Apply.
Therefore, you can make small changes to values in the dialog box to see 
how the object changes on screen each time you click Apply.

To reset all of the values in the dialog box:
Click Reset.
Note: The object does not change. Any changes previously applied remain.

To undo all changes made with the Transform dialog box:
Click Cancel Actions.

After closing the Transform dialog box, clicking Undo (on the Model Settings
ribbon or from the Edit menu) cancels all changes made with the dialog box.
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Changing an 
Object’s 
Orientation

There are several methods for changing the orientation of objects on the
build tray.

To rotate an object:
Select the object and use the Object menu options (see also
“Repositioning Objects” on page 32).

To re-align an object’s plane:
1. On the Tray Settings or Model Settings ribbon—

a. Click the icon in the Selection group: or .
b. On the flyout toolbar, click the Select Plane icon:

or—
From the Tools menu, select Plane Alignment > Select Plane.

2. Click on part of an object on the build tray.
The selected plane is displayed.

Figure 5-44: Aligning by plane

Alignment 
toolbar

Selected 
plane
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3. On the Alignment toolbar, click an appropriate icon to change the
alignment.
or—
From the Tools menu, select Plane Alignment, and select an alignment
option.

Figure 5-45: Tools menu, Plane Alignment options

To cancel plane selection after re-aligning objects on the build tray:
On the Tray Settings or Model Settings ribbon—

a. Click the icon in the Selection group: or .
b. On the flyout toolbar, click the Select Element or Select Group icon:

or—
From the Tools menu, select Plane Alignment > Select Plane.

To flip an object 180 degrees on any axis:
1. Select the object.
2. From the Object menu, select Flip > Flip X / Flip Y / Flip Z.

To make precise changes to the object’s orientation on any axis:
1. Select the object.
2. Display the Transform dialog box (see figure 5 43 on page 33).
3. Change the Rotate parameters for each axis.
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Grouping and 
Ungrouping 
Objects

You can manipulate two or more objects on the build tray, at the same time.
• Selecting multiple objects

Manipulating done to one object affects all selected objects. For
example, turning one object on its axis causes all selected objects to turn
on their respective axes.

• Converting the objects to an assembly
Separate objects become parts of one unit. For example, turning the
assembly on its axis causes all its component parts to turn as one unit.

To convert objects to an assembly:
1. Select the objects (see “Selecting Objects” on page 18)
2. From the Object menu, select Group to Assembly.

In the model tree, the objects now appear as children of a parent
(assembly).

Figure 5-46: Assembly in the model tree

After creating an assembly, you can save it as an objdf file, for re use.
(Saving the assembly is not necessary for manipulating and printing it.)

To save an assembly:
1. Select the assembly (either on the build tray or in the model tree).
2. From the Objet Studio Commands menu , select Save As.
3. In the Save As dialog box, select the objdf format, choose a location,

name the file, and click Save.

To separate assemblies into individual objects (stl files):
1. Select the assembly (either on the build tray or in the model tree).
2. From the Object menu, select Ungroup.

In the model tree, the elements are not parts of an assembly.

Figure 5-47: Separate objects in the model tree
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Freezing Model 
Orientation

If you manipulate an object on the build tray, you can freeze its orientation
so that it does not change when you position it automatically (see
“Automatic Placement” on page 26).

To freeze an object:
1. Select an object on the build tray.
2. On the Model Settings ribbon, in the Manipulate group, or on the Model

Toolbar, click .

To unfreeze an object:
Select the object and click (to de select it).

Display Options
Viewing
Objects

From the View menu, you can change the way objects are displayed. The
default method for displaying models on the build tray is as solid
(“shaded”) objects.

Figure 5-48: Tray and model displayed in Shaded view

The other display options are WireFrame and Points.

To display the build tray in WireFrame view:
From the View menu, select WireFrame.

Figure 5-49: Tray and model displayed in WireFrame view

To revert to the shaded view:
From the View menu, select Shaded.
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To display objects as boxes, showing their maximum dimensions 
instead of their shape:

From the View menu, select Display Bounding Box.

Figure 5-50: Model displayed with bounding box

To display the area around objects needed for support material (to 
produce a matte finish):

From the View menu, select Display Thickening Box.

Figure 5-51: Model displayed with thickening box

To display the maximum build height:
From the View menu, select Display Tray 3D Box.
Figure 5-52: Tray 3D Box

To display objects without the build tray:
From the View menu, clear (de select) the Display Tray option.
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Screen Layout Objet Studio automatically adjusts the default screen layout to display the
optimum views of the build tray and the model tree. You can view models
from different perspectives by changing the screen layout.

To change the screen layout:
On the View flyout toolbar, select Single View, or 4 Views.

Figure 5-53: Screen layout icons

Single View is the default screen layout.
4 Views displays perspective, top, front and right views.

Figure 5-54: Single-view screen layout

Figure 5-55: 4-view screen layout

Tray 
Perspective

The default perspective of the build tray is “isometric.” You can change the
perspective of the active window with one of ten options.

To change the perspective of the build tray in the active window:
1. On the Tray Settings ribbon, open the Perspective flyout toolbar.

Figure 5-56: Perspective flyout toolbar

2. Click the icon that represents the desired perspective.
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Tray Positioning To view the tray and models from different directions, you can move the
tray around the screen and change its display angle.

To move the tray in the Objet Studio screen:
Press the mouse wheel while moving the mouse.

Figure 5-57: Tray after moving it in the Objet Studio display

To manually rotate the tray:
Press Alt and press the mouse wheel while moving the mouse.

Figure 5-58: Tray after rotating it upside-down
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Setting Object 
Colors

The color of objects on the build tray can indicate how they are printed.
Objet Studio enables you to choose the color display so that you can easily
see the material, surface and coating of objects.

To choose how colors are applied on the display:
On the Model Settings ribbon, in the Colors group, select one of the
options from the flyout toolbar.

Figure 5-59: Colors display options

Loading Large 
Files

Very large stl files can be slow to load and may be difficult to manipulate
easily on the build tray. If this is the case, you can display just an image of
the object on the build tray without loading the entire file. The stl file itself
is not changed, and the complete file is sent to the printer.

To display an image of stl files when you place objects on the build tray:
1. From the Tools menu, select Options, and display the Settings tab.

Figure 5-60: Options dialog box, Settings tab

2. In the Large Files section, select Load Partial (reduced).

Color Indicates Model material

Color indicates Model surface

Color indicates if coating is used

Before sending a build tray to the printer, or when you perform tray 
validation, Objet Studio checks if there is a problem with the stl files or the 
positioning of objects on the tray. If so, the affected objects are displayed 
with special colors (see “Tray Validation” on page 45). 



Using Objet Studio

5–42 DOC08010 Rev. A (DRAFT 1)

Large File 
Manipulation

If you need to work with a detailed model that is composed of a large
number of polygons, you can speed up its display and manipulation in
Objet Studio by reducing the number of polygons on the screen. Although
this may reduce the resolution on the screen, it has no affect on the printed
models.

Figure 5-61: Object displayed without polygon reduction

Figure 5-62: Object displayed with only five percent of its polygons showing

To use polygon reduction:
1. From the Tools menu, select Options.

or—
From the Objet Studio Commands menu , click Options.

2. In the Options dialog box, display the Display tab.

Figure 5-63: Options dialog box, Display tab

3. Select Enable Polygon Reduction.
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4. Select Polygon Reduction (Percent).
5. Enter the percentage of total polygons to display.

When you click Apply, the display changes.

Note: The setting affects the static display (when the object is not being 
moved).

6. Set display options when the object is being moved (Display while
changing view):
• Bounding Box—A box representing the object’s maximum

dimensions is displayed.
• Adaptive Polygon Reduction—Varying degrees of polygon reduction

are applied, as necessary.
• Entire Object—No polygon reduction is applied.

7. To save these settings, so that they will be applied every time you place
this object on the build tray, click Save Polygon Reduction Data.

8. Click Apply to see the results of the settings without closing the dialog
box.

Object display
options

The display format affects how quickly objects display. For example, if you
select Bounding Box, objects display faster than they do when you select
Entire Object. You can choose display formats for objects when they are
stationary (static view) and for when you are dragging them (changing view).

To select the object display preference while changing view, and in static 
view:
1. Select to display objects:

• With a Bounding Box (see figure 5 50 on page 38)
• With Adaptive Polygon Reduction (changing view only)
• With Polygon Reduction (static view only)
• Entire Object

2. Click OK when done.

Selecting the Entire Object option cancels polygon reduction.
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Zoom Options While manipulating objects, you often need to view them at different zoom
levels.

To change the zoom level:
On the ribbon, open the Zoom flyout toolbar and select an option:

Figure 5-64: Zoom flyout toolbar

Zoom Object focuses on the selected object.
Zoom Tray displays the whole tray.
Zoom by Rectangle allows you to display a section of the tray by
selecting it with the mouse.

You can also zoom in and zoom out with the mouse wheel.

Zoom Object

Zoom Tray

Zoom by Rectangle

You can configure Objet Studio to automatically zoom in on the objects 
placed on the build tray. See “Automatic Zoom” on page 63.
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Handling Completed Trays
After you have properly placed all objects on the build tray, you save the
tray as an objtf file, which is sent to the 3D printer for production. But before
saving the tray, you can check that there would be no problem producing it.
You can also calculate how much material would be consumed during
production and how much time this would take.

Tray Validation Before sending a job to the printer for production, you should check that
the tray is “valid” and can be printed.

Note: Because of the unique characteristics of each type of modeling 
material, make sure that the correct material is selected before
performing Tray Validation.

To validate that the tray can be printed:
On the Tray Settings ribbon, in the Build Process group, click .
or—
From the Tools menu, select Placement Validation.
If the tray is not valid, the color of the problematic models on the tray
changes according to a pre set code.

Figure 5-65: Color code

Note: The “Both” color also indicates a problematic stl file.
The validation status appears on the bar at the bottom of the screen.

Figure 5-66: Validation details in status bar
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Production
Estimates

Objet Studio enables you to calculate the time and material resources
needed for producing trays before sending them to the printer. The time it
takes Objet Studio to perform this calculation depends on the number of
objects on the tray and their complexity. Calculating the production
estimate for a full tray could take up to 15 minutes, depending on your
computer’s specifications.

To calculate the time and materials needed for producing the current 
tray:

On the Tray Settings ribbon, in the Build Process group, click .
While the estimate is being calculated, a progress bar is displayed—on
the right side of the status bar (at the bottom of the screen).

Figure 5-67: Estimate progress bar

When Objet Studio finishes calculating the production resources, the
results are displayed in a dialog box.

Figure 5-68: Production resource calculations for different printing modes

As shown in the Production Estimates dialog box, the resources needed for
producing the models on the tray depend on the printing mode used by the
printer when producing the job. You might want to consider these
estimates when deciding on the printing mode (see below), and whether or
not to allow using substitute model materials when printing the job.

Note: You select the printing mode and material substitute options after 
you send the build tray to the printer (see “Printing the Tray File” on 
page 48).

Cancel
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Printing Modes Stratasys printers can build models using three possible printing modes.

HQ (High Quality) Mode—
• Models are printed in 16 micron layers, resulting in smooth surfaces,

suitable for producing fine detailed and delicate items.
• Almost twice as much time is required to print most trays, compared to

the High Speed setting.
• This setting is only available when model material can be used in four

print heads, in single material printing.

HS (High Speed) Mode—
• Models are produced in 30 micron layers, suitable for producing larger

models.
• Much less time is required to print most trays, compared to the

High Quality setting.
• This setting is only available when model material can be used in four

print heads, in single material printing.

Digital Material Mode—
• Used when producing trays designed to be fabricated from .
• Used when producing a tray containing two or more models, each

designed to be made from a different (single) model material.
• Used when producing models from only one of the model materials

loaded in the printer by printing with only two of the print heads.
• Models are produced in 30 micron layers, but the printing is near high

quality.
• Printing time is similar to printing time in High Quality mode.

Although printing time is longer than with High Speed mode, Digital
Material mode can make material replacement unnecessary—saving
both time and the cost of wasted model material.

You can see estimates of time and material resources needed for printing
trays using the different printing modes (see “Production Estimates” on
page 46). You also see these production estimates when you send the tray
to the printer. At that time, you can select the printing mode, including an
option that enables Objet Studio to print the tray by the most efficient
method (see “Printing Mode Selection” on page 48).

Single-material printing: All print heads print models without regard to the 
source of the model material. This happens in the following situations:

All print heads are supplied with one model material.
Each pair of print heads is supplied with a different model material, but 
models are printed as if they were the same material. The result is an 
arbitrary mixture of materials in the printed model.

Digital Material Mode is selected automatically when more than one model 
material is assigned to objects on the tray.
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E-mailing 
Objet Digital 
Files

You can easily e mail objdf files using Microsoft® Office Outlook®. Sending
objdf files is recommended (instead of stl files) because the size of a file is
typically reduced by more than half. An added benefit is that the objdf file
contains the model material information for the object.

To e-mail a file:
1. From the Tools menu, select Email Objet Digital File.

Outlook opens with the file attached and Subject details added to the
e mail form.

2. Enter the e mail address and send the file.

Printing the 
Tray File

When a tray is ready to be printed, it is placed in the Jobs Queue. When the
job reaches the head of the queue, Objet Studio pre processes the tray file to
create slices, and feeds them to the 3D printer.

To send the tray to the print queue:
1. On the Tray Settings ribbon, Build Process group, click .

• If printing the tray requires (Digital Material mode), the Job
Summary dialog box opens.
Figure 5-69: Job Summary when printing with multiple model materials

Note:The values displayed are the result of a quick calculation, and 
represent a rough estimate of the materials and time input required to 
print the job. For a more accurate calculation, click Fine Estimation.
Continue with step 4 on page 5 50.

• If printing the tray requires only one model material, the Printing
Mode Selection dialog box opens.

Figure 5-70: Printing Mode Selection dialog box

Note:The values displayed are the result of a quick calculation, and 
represent a rough estimate of the materials and time input required to 
print the job. For a more accurate calculation, click Fine Estimation.

Printing-Mode
Selection

2. Select the appropriate printing mode.
• If you require the job to be printed in High Quality mode, select this

option.
Note:The availability of High Quality mode depends on the material 
selected.

• If you require the job to be printed in High Speed mode, select this
option.

• If you do not require the job to be printed either in High Quality or
High Speed mode, select Automatic.
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This setting enables the Stratasys software to determine (just before
printing) the most efficient way to print the tray. Digital Material mode
is used if this removes the need to perform the Material Replacement
procedure. Otherwise, High Speed mode is used.
For example, if printing the tray requires only one of the model
materials loaded in the printer, only the two print heads using that
material are used to print models—Digital Material mode. (High
Quality and High Speed modes call for printing model material with
four heads, which would require you to perform the Material
Replacement procedure.)
On the other hand, if printing the tray can be done using four print
heads without running the Material Replacement procedure, High
Speed mode is used. This is possible if all print heads are supplied with
one model material, or if you allow printing with an arbitrary mixture
of similar materials (see below).

3. Click Next.
The Model Material Substitution dialog box opens—if this is relevant for
the tray. (If not, the Job Summary dialog box opens—continue with
step 4.)

Model Material
Substitution

Figure 5-71: Model Material Substitution dialog box

If you allow the use of substitute model materials, the printer will use
different materials whose characteristics (strength, flexibility, etc.) are
similar to those of the material you assigned to the object when
designing the build tray—under the following conditions:
• The material you assigned is not installed in the printer at the time

of printing.
In this case, the tray is printed with either one or two substitute
materials (depending on the materials installed in the printer at the
time of printing). If possible, High Speed mode is used.

• In addition to the material you selected, there is another (similar)
material installed in the printer at the time of printing.
In this case, High Speed mode is used, by printing with a mixture of
the two materials (as if they were the same material).

Model Quality When Digital Material Mode is Used

Near-high-quality is achieved for most models. 
If all objects on the tray are inserted from individual stl files, they are 
printed with the standard resolution of 600 dpi (dots per inch) along the 
Y-axis—unless glossy finish is required (see “Surface Finish” on page 23).
If there is an assembly on the tray, all of the models on the tray are 
printed with a resolution of 300 dpi along the Y-axis. 
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4. Click Build.
If the build tray file has not been saved, the Save As dialog box opens for
you to save it now.
Objet Studio checks if there is a problem with the positioning of objects
on the tray. If so, the affected objects are displayed with special colors
(see “Tray Validation” on page 45), and a warning message appears.

Figure 5-72: Tray validation warning message

• To cancel the Build command so you can correct the problem, click
No.

• To print the models as they are positioned on the tray, click Yes.

The Job Manager screen opens, so you can monitor the progress of your
trays—before, during, and after printing. See “Monitoring and
Managing Print Jobs” on page 68.
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Applying Additional Objet Studio Features
Dividing 
Objects

You can use the Split Object feature to produce objects larger than the tray
area by dividing the model into separate parts. With this feature, you
produce only a specific section of a model.

To split an object:
1. Select the object.
2. From the Object menu, select Split.
3. In the Split Object dialog box, enter the values to determine how Objet

Studio will divide the object. You can divide an object along any of its
axes, by entering either exact measurements or the number of parts.

Figure 5-73: Split Object dialog box

4. In Save to Folder, enter the folder name.
5. Click OK.

The composite parts are saved as new stl files with “Part 1,” “Part 2,”
etc., added to the original file name.

Note: Before printing the newly created stl files, it is recommended that you 
check them for defects in an STL-repair application, such as 
Magics™, by Materialise®.
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Choosing the 
Support
Strength

When producing models, support material fills some hollow and empty
sections (see “Model Orientation” on page 26). Objet Studio allows you to
adjust the strength of the structure formed with the support material. This
adjustment is useful when producing either large/massive models or small/
delicate models. For most purposes, the default setting provides adequate
support strength.

To change the strength of the support structure used when printing a 
model:
1. Select a model on the tray.
2. On the Model Settings ribbon, in the Options group, click .

or—
• On the Model Toolbar, click .
or—
• From the right click context menu, select Advanced Properties.
The Advanced Properties dialog box opens.

Figure 5-74: Advanced Properties dialog box

3. In the Grid Style section, choose the support strength suitable for the
selected model. You can select a different support strength for each
model on the tray.
• Standard—for models needing average support (most models).
• Heavy—for large models needing much support.
• Lite—for delicate models needing little support. (This setting makes

it easy to remove the support material.)

Note: If an object is split into shells, the Advanced Properties enabled vary 
with the object selection. If a single element is selected only Hollow
is enabled. If a group of elements is selected only Grid Style is 
enabled.

4. Click Apply.
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“Hollow”— 
Filling Models 
with Support 
Material

Many objects placed on the tray from stl files are “solid.” This means that,
when printed, the model will be completely filled with model material.
Often, especially with large objects, this is unnecessary. Instead, the model
can be filled with support material, which is less costly. It is also advisable
to fill models with support material when preparing them for investment
casting, since this material burns off more quickly during the process of
making the cast.
Objet Studio enables you to print objects on the tray with an outer shell of
model material and a center filled with support material. When using this
feature, called “Hollow,” the thickness of the shell should be no less than
0.5 millimeters.

To use the Hollow feature:
1. Select a model on the tray.

or—
• On the Model Toolbar, click .
or—
• From the right click context menu, select Advanced Properties.
The Advanced Properties dialog box opens.

2. Select Hollow.

Figure 5-75: Advanced Properties dialog box

3. Set the shell thickness, in millimeters.
4. Click Apply.

Note: There is no change in the display of objects in Objet Studio when 
Hollow is selected.

To inspect, change or cancel the Hollow setting:
1. Select a model on the tray.
2. Access the Advanced Properties dialog box, as above.
3. If you change or cancel the Hollow setting, click Apply.
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Displaying the 
Cross Section 
of Objects

The Section feature enables you to view the interior of an object by “slicing”
it on any axis. You can then manipulate the object to inspect the interior
from different angles. This may be important for deciding on the type of
support necessary when producing the model (see “Choosing the Support
Strength” on page 52). Displaying an object’s cross section only affects how
the tray is displayed on the screen; it does not change the object itself.

To display a cross section of the tray:
1. From the Tools menu, select Section.

The Section dialog box opens.

Figure 5-76: Section dialog box

2. Select Enable Clipping.
3. Use the slider controls for the X , Y , and Z axes to cut the tray so that

you see the cross section you want.

Figure 5-77: Whole view Figure 5-78: Cross-section view, after 
using the Z-slider
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Saving the 
Screen Display 
as an 
Image File

You can save the image displayed in the active viewing screen as a graphic
file.

To save the screen display as an image:
1. Press Ctrl+B.

or—
From the Objet Studio Commands menu , select Save Bitmap.
The Save Bitmap dialog box opens.

Figure 5-79: Save Bitmap dialog box

2. At the top of the dialog box, select the appropriate folder.
3. At the bottom of the dialog box, enter a file name.
4. Open the Save as type drop down list, and select the file format.
5. Click Save.
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Exporting and 
Importing 
Objet Build 
Trays

When you save build trays in Objet Studio, they are saved as objtf files.
These files contain instructions to Objet Studio and to Stratasys printers for
displaying and producing the stl files used on the tray. To conveniently
save all of the files as they are positioned on the build tray, for storing the
job, or for transferring it to another location, Objet Studio compresses them
into one objzf file. To later use the objzf file, the file must first be expanded
in Objet Studio and its component files saved.

Note: If you export an objzf file containing a stl file originally saved as read-
only, you cannot open (import) this objzf file to the folder where the 
read-only stl file is saved.

To create an objzf file:
1. From the Objet Studio Commands menu , select Export Packed Job.

The Save As dialog box opens.
2. Select the appropriate folder and change the file name (if necessary).
3. Click Save.

To open an objzf file:
Double click on the objtf file.
or—

1. From the Objet Studio Commands menu , select Import Packed Job.
2. In the Open dialog box, display the appropriate folder and select the

file.
3. In the Browse for Folder dialog box, display the folder in which you

want Objet Studio to expand the compressed file, and click OK.
The objtf file and associated stl files are expanded and placed in the
selected folder, and the tray is displayed in Objet Studio.

Note: You can also export a print job as an objzf file from the Job Manager
screen—see “Exporting Jobs (objzf)” on page 80.
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Customizing Objet Studio
You can customize Objet Studio to suit your particular working needs and
preferences. Features that you can customize include:

• Creating a quick access toolbar for frequently used commands.
• Changing the position of the Quick Access toolbar.
• Minimizing the ribbon.
• Changing the Objet Studio color theme.
• Configuring default settings for objects placed on the build tray.

Creating a 
Quick Access 
Toolbar

As you work with Objet Studio, you may use certain commands frequently.
You can create a quick access toolbar to make your work easier.

To create a quick-access toolbar:
1. Above the ribbon tabs, click .

The Customize Quick Access Toolbar menu opens.

Figure 5-80: Customize Quick Access Toolbar menu

2. Select a command you want to add to the toolbar.
An icon for the selected command is added to the toolbar.

Figure 5-81: Quick Access toolbar

To add another command, repeat the above procedure.
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3. To choose from a wider range of commands:
• From the Customize Quick Access Toolbar menu (see figure 5 80 on

page 57), select More Commands.
or—
• Right click on the Objet Studio Commands icon , or elsewhere

on the ribbon, and select Customize Quick Access Toolbar.

Figure 5-82: Right-click ribbon menu

The Options dialog box opens.

Figure 5-83: Quick Access Toobar Options dialog box

4. Open the drop down list and select either Popular Commands or
Commands not on the Ribbon.

5. Select a command and click Add.
6. Click OK.

Hiding the 
Ribbon

To make more room for displaying the build tray, you can hide the Objet
Studio ribbons.

To hide the ribbons:
1. Right click anywhere on the ribbon or on the menu bar, or in the Objet

Studio Commands menu .
2. Select Minimize the Ribbon.

The ribbons disappear, but you can temporarily display the ribbon
icons by clicking Tray Settings or Job Manager on the menu bar. When
you next click outside of the ribbon, it disappears again.

To return the permanent ribbon display:
Repeat the steps above to cancel Minimize the Ribbon.
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Display Colors You can customize some of the colors used for displaying Objet Studio
screens and for displaying objects on the build tray.

To change the colors used in Objet Studio screens:
1. From the Tools menu, select Options.

Figure 5-84: Display settings

2. In the Appearance tab of the Options dialog box, you can configure the
display.
• The Mode selection determines how models appear on the build

tray. The default method for displaying models on the build tray is
as solid (“shaded”) objects. The other options are WireFrame and
Points.

• If Shaded is selected, you can display the model on the tray as a see
through object.

Figure 5-85: Transparent display

• Double click the color patches to customize colors.
• The Windows Background Color settings enable you to change the

color behind the build tray—with either a solid or a two color
gradient.

• To return to the default display settings, click Default.
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Changing Color
Themes

Objet Studio offers a choice of four background color themes—blue, black,
silver and aqua.

Figure 5-86: Background color themes

To change the color theme:
From the Style menu, select one of the options.

Keyboard 
Shortcuts

You can define shortcut keys for frequently used commands.

To define shortcut keys:
1. Above the ribbon tabs, click .

The Customize Quick Access Toolbar menu opens.

Figure 5-87: Customize Quick Access Toolbar menu

2. Select More Commands.
The Options dialog box opens (see figure 5 83 on page 58).
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3. Click Customize.
The Customize Keyboard dialog box appears.

Figure 5-88: Customize Keyboard dialog box

4. Select command Categories to display all the commands in that
category, for example, all the Model Settings commands.
Current shortcut keys are displayed.

5. Enter the shortcut key in the Press new shortcut key field, and click
Assign.

6. If you want to redefine all shortcut keys, click Reset All.

Setting User 
Preferences 

You can change several Objet Studio settings that affect objects placed on
the build tray.

To change default settings:
From the Objet Studio Commands menu , select User Preferences.

Figure 5-89: Setting work preferences

• Building Style—see “Surface Finish” on page 23.
• Grid Style—see “Using a Grid to Position Objects” on page 30.
• Application Settings—see “Choosing the Support Strength” on page 52,

and “Freezing Model Orientation” on page 37.
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Professional Mode Features
Some advanced features of Objet Studio are only accessible in Professional
Mode.

To see the current Objet Studio setting:
Open the Tools menu.

Figure 5-90: Tools menu, showing Professional Mode selected

If Professional Mode is selected, advanced features are displayed.

To change the Professional Mode setting:
1. From the Tools menu, select Professional Mode.

The following message is displayed, reminding you that the change
will only take effect the next time you open Objet Studio—even though
the check mark next to the Professional Mode option appears
immediately.

Figure 5-91: Configuration-change message

2. Close and re open Objet Studio to use the Professional Mode features.
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Default 
Settings

You can control the default settings of several Objet Studio features from
the Advanced tab of the Options dialog box.

To display the Options dialog box 
From the Tools menu, select Options.
or—
In the Objet Studio Commands menu , click Options.

Figure 5-92: Options dialog box, Advanced tab

Automatic
Orientation

By default, when Objet Studio places objects on the build tray, it orients
them optimally, for the shortest printing time. If necessary, you can choose
to cancel automatic orientation each time you place an object on the build
tray (see “Automatic Orientation” on page 25). In any case, when objects
are on the build tray, you can change their orientation manually (see
“Model Orientation” on page 26.)

To change the default setting so that Automatic Orientation is disabled:
In the Advanced section of the Options dialog box, clear the check box.

Automatic Zoom When Auto Zoom is selected in the Advanced section of the Options dialog
box, the display zooms in, to display the objects placed on the build tray.
This allows you to carefully inspect and manipulate the objects.
By default, this feature is not enabled. In any case, you can change the
zoom level, as necessary (see “Zoom Options” on page 44).
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OpenGL Driver 
Configuration

The OpenGL driver displays 3D graphics on your screen. There is normally
no reason to adjust its settings. If you suspect a problem with the way Objet
Studio displays objects, you can use the OpenGL Driver Configuration tool
to check and configure the driver settings.

To access the OpenGL Driver Configuration dialog box:
1. From the Tools menu, select Options.

or—
In the Objet Studio Commands menu , click Options.

2. In the Options dialog box, display the Troubleshooting tab.

Figure 5-93: Access to OpenGL Driver configuration

3. Click OpenGL Driver Configuration.
The dialog box that opens displays details of the pixel format ID (index)
for the window and the memory.

Figure 5-94: OpenGL Driver Configuration dialog box

If you want to display the values and change them, click . Alternately,
you can select Choose Format and change the values in this dialog box.

The Troubleshooting tab is only accessible when Professional Mode is 
active (see “Professional Mode Features” on page 62).
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To perform a test of the driver configuration and enter the suggested 
pixel format ID:
1. Select Choose Format.
2. Click Test.

Objet Studio returns the recommended pixel format ID.

Figure 5-95: Recommended pixel format ID

3. Click OK.
4. In the OpenGL Driver Configuration dialog box (figure 5 94), select Pixel

Format ID and enter this number.
5. Click Apply.
6. Display the other pixel format tab, and repeat this procedure.
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Getting Additional Objet Studio Assistance
Objet Studio Help provides on screen instructions and information, as you
work.

To view Objet Studio Help:
On the standard toolbar, click and then click Objet Studio Help.

Figure 5-96: Help options

You can also view information on the following subjects:
• Troubleshooting opens a list of error messages and their

explanations.
• Check for Updates checks if you are using the latest Objet Studio

version.

Objet Studio Version, Material Module and Licensed Features
You can view details of the Objet Studio version, the material module
installed, and the features available with your license.

To view details of your Objet Studio installation:
On the standard toolbar, click and then click About....

Figure 5-97: Displaying Objet Studio details

About Objet Studio
tab

The About Objet Studio tab shows the Objet Studio version number and
basic information about your computer.

Figure 5-98: About Objet Studio tab
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Materials Module
tab

The Materials Module tab shows details of the material module installed.

Figure 5-99: Materials Module tab

• Module version
If a Materials Module upgrade (patch) was installed, the new Materials
Module version is displayed. If no patches were installed, the Module
version is the same as the Objet Studio version.

• Module date
If a Materials Module upgrade (patch) was installed, the date of its
creation is displayed. If no patches were installed, the Module date is the
date of the Objet Studio version.

• Module properties
If a Materials Module upgrade (patch) was installed, its description is
displayed. If no patches were installed, “Default” is displayed.

Feature License
tab

The Feature License tab shows the Objet Studio features available with your
license.
Figure 5-100: Feature License tab

Click to expand the details for each feature.
• Modes shows the printing modes available.

See “Printing Modes” on page 47.
• Materials shows basic model materials available.
• Mixed Tray shows if your license enables printing a build tray

containing objects, using a different model material for each.
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Monitoring and Managing Print Jobs
In the Job Manager screen of Objet Studio, you monitor and manage jobs
sent to the printer. There are a few differences between Objet Studio on
client workstations and on the computer connected directly to the 3D
printer—the server workstation.
• Objet Studio installed on a client computer only displays the queue and

status for jobs sent to the 3D printer server from that computer, and it
allows the user to edit only these jobs.
Note: If there are several Objet printers on the local network, client 
computers can connect to any of them, but only one at a time.

• Objet Studio installed on the computer directly connected to a specific
3D printer (server), displays the queue and status for all jobs sent to that
3D printer by the server and by all client computers on the network. It
also allows editing and manipulation of all jobs, and enables re sending
previously printed jobs to the printer.

Job Manager 
Screen

The Job Manager screen on the client and server workstations looks
identical. The only difference is that options only relevant to the server
workstation are disabled for client installations.
Figure 5-101: Job Manager screen

The Job Manager screen is divided into panels:
• Jobs Queue
• Printing Progress
• History
• Available Resources
• Material Consumption
• Tray Preview
• Waste

If Objet Studio is not connected to a printer (or printer server), you can 
prepare tray files for any Objet printer. Later, these files can be used by 
Objet Studio on the appropriate printer server.
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Jobs Queue On the server, the Jobs Queue lists the last 15 jobs sent from client computers.
On client workstations, the Jobs Queue lists jobs sent from that computer to
the printer server.
Information for each of the queued jobs is displayed, including the job status.

In addition, the following information is displayed:
• Owner—the computer that sent the job
• Build Time—the estimated building time for the job
• Model Consumption—the amount of model material required to

complete the job, and the amount actually used till now
• Support Consumption—the amount of support material required to

complete the job, and the amount actually used till now
• Printing Mode—HS=High Speed, HQ=High Quality, DM=Digital

Material
Printing Progress The Time panel shows printing times and the number of slices sent to the printer.

History The History panel shows information for the last 50 jobs and their final
status. You can drag a job from History to Jobs Queue to print the tray again.

Available
Resources

The Available Resources panel contains graphic indicators that show the
amount of available printing materials remaining in the printer.*

Material
Consumption

• Actual—the amount of material used till now
• Required—the amount of material still needed to finish the job

Tray Preview The Tray Preview panel displays the build tray view of the job selected in the
Job Queue or the History list.
On a server, you can open an enlarged preview window by clicking on the
Tray Preview display (see “Extended Tray Preview” on page 78).

Waste If you move the mouse over the Waste display, the amount of waste in the
container is displayed.

Status Meaning

Waiting Printing of this job has not started.

Building Printing of this job is in progress.

Stopped Printing of this job was interrupted. Printing can later be
continued (Resume) or begun again (Restart).

Error Errors occurred during the printing of this job, and it was
placed in the Jobs Queue again.

Editing This job is now being edited in Objet Studio.

Spooling The job file is being spooled in the printer.

Preprocessing The 3D printer is readying itself for printing: the cover
locks, print heads warm up and are put in starting position,
UV lamps are turned on, and the build tray level is
adjusted.

On Schedule The job is scheduled to be printed at a specified time.

* Objet Studio displays the weight of the printing materials in both cartridges
as long as each cartridge contains more than 100 grams of material. The
weight under 100 grams is not calculated and displayed. However, if a
cartridge contains less than 100 grams of material, the printer uses it—as
long as the material in the other cartridge weighs more than 100 grams. In
any case, the weight of each cartridge is displayed in the printer application.



Using Objet Studio

5–70 DOC08010 Rev. A (DRAFT 1)

Setting the 
Printer
Connection

When an Objet 3D printer is installed, the server computer is connected to
that printer. Normally, there should be no reason to change this connection.
Occasionally, however, you may need to reset the connection, to connect
the server to another printer, or to use Objet Studio in off line mode
(without a printer connection).

To set (or change) the printer connection:
1. On the Job Manager ribbon, in the 3D Printer group, click .
2. In the Set Printer dialog box, click Connect.

Figure 5-102: Connecting to a printer (A)

3. Enter the computer name or its IP address, or click Browse to find and
select it.
Figure 5-103: Connecting to a printer (B)

4. Click OK.
When the connection is established, Objet Studio is configured to
prepare print jobs for that printer.

If you can see the material levels in the Job Manager screen (see 
figure 5-101 on page 68), Objet Studio is connected to the printer.
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Off-line Mode You can use Objet Studio to prepare trays for printing in off line mode, on
a remote computer or when the printer connection is not available. You also
use off line mode to prepare trays for printing with other printers. In this
case, if Objet Studio is currently connected to a printer, you must change to
off line mode by removing this connection.

To disconnect Objet Studio from the printer:
1. On the Job Manager ribbon, in the 3D Printer group, click .
2. In the Set Printer dialog box, click Connect (see figure 5 102).

Figure 5-104: Disconnecting Objet Studio from a printer (A)

3. In the Printer Connection dialog box, delete the computer name/IP
address.
Figure 5-105: Disconnecting Objet Studio from a printer (B)

4. Click OK.
“Unknown” appears in the printer name field.

5. Click OK.
6. In the pop up message, confirm that you want to work in off line mode

by clicking No.

Figure 5-106: Off-line message

When Objet Studio is in off line mode, you can configure it for preparing
print jobs for different printers.
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To change the Objet Studio off-line configuration:
1. In the Set Printer dialog box, select a printer type.

Figure 5-107: Off-line printer selection

2. Click OK (not “Connect”).
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Setting the 
Remote Printer 
Connection 
(Client Mode)

When you open Objet Studio for the first time in a client installation, you
are prompted to connect to an Objet server computer that sends jobs to a 3D
printer. To do this, the server computer must be operating and connected to
the local network.

To set (or change) the connection to the server-computer:

1. On the Job Manager ribbon, in the 3D Printer group, click .
2. Enter the name of the server computer or its IP address, or click Browse

to find and select it.
3. Click OK.

Figure 5-108: Printer Server Connection dialog box

Job Manager 
Commands

The Job Manager ribbon has three icon groups:
• 3D Printer
• Queue
• Job

Figure 5-109: Job Manager ribbon commands

Icons are enabled or disabled according to their relevancy. For example,
since you cannot stop printing a job that is not being printed, the Stop
command is disabled when the printer is idle.
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The following operations are available on the Job Manager ribbon:

Group Icon Purpose

3D
Printer

Client: Sets the server connection. See “Setting the Remote
Printer Connection (Client Mode)” on page 73.
Server: Sets the printer connection. See “Setting the Printer
Connection” on page 70.

Configures options for printer alerts. See “Configuring User
Alerts” on page 76.

Queue Server: Moves a job to the head of the Jobs Queue.
Client: Disabled.
See “Jobs Queue” on page 69.

Server: Moves a job to a higher position in the Jobs Queue.
Client: Disabled.
See “Jobs Queue” on page 69.

Server: Moves a job to the bottom of the Jobs Queue.
Client: Disabled.
See “Jobs Queue” on page 69.

Server: Moves a job to a lower position in the Jobs Queue.
Client: Disabled.
See “Jobs Queue” on page 69.

Job Server:
• For a job in the Jobs Queue—Prints it again (from the

beginning).
• For a job in the History list—Moves it to the Jobs Queue

for printing.
Client: Disabled.
See “Restarting Jobs” on page 79.

Server: Stops a job in progress.
Client: Disabled.

Server: Continues printing the current job from the point
where printing stopped.
Client: Disabled.
See “Resuming Jobs” on page 79.

Removes the selected job from the queue.

Refreshes the image of the selected job in the Tray Preview
display.

Opens the Tray Settings screen and displays the tray. For
deleted jobs, this enables you to make changes before
printing.
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In addition to using ribbon command icons, you can use commands on
context (pop up) toolbars and from the Job menu on the standard toolbar.

Figure 5-110: Icons on pop-up toolbar (server)

Figure 5-111: Icons on pop-up toolbar (client workstation)

Note: Most icons and menu commands are only enabled when a job is selected.

Figure 5-112: Job menu options (server)

Stop

Edit

Export 
packed job

Schedule

Resume

Restart

Delete

Edit

Delete

When you position the cursor over an item, a tooltip displays the name of 
the command.
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Configuring
User Alerts

Objet Studio can alert you (and others) to the status of jobs sent to the server
for printing. This is especially useful during long printing jobs, when the
operator is away from the printer. The following events can be reported:
• The level of model or support material is low.
• The job was interrupted.
• The job was completed successfully.
To send e mail and SMS alerts, make sure that e mail software supporting
MAPI is installed on the server computer. To send SMS alerts, the cellular
phone service must support the transmission of e mail messages by SMS.
Only the subject line of the e mail message is transmitted by SMS.

To configure Objet Studio to send notifications and alerts:

1. On the Job Manager ribbon, in the 3D Printer group, click .

Figure 5-113: Notifications dialog box (server)

Figure 5-114: Notifications dialog box (client workstation)

2. Set the desired reporting options.
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3. Click Details.

Figure 5-115: Event selection for alerts

4. In the Reports Events dialog box, select the alert events and click OK.
5. In the Notifications dialog box, click OK.

Printing the 
Tray

If there is a job in the Jobs Queue, it is sent automatically to the Stratasys
printer—as long as it is on, there is a connection to the printer, and the
printer is on line. Chapter 6 describes starting and operating the printer.

Additional
Server 
Features

Objet Studio on the printer server includes the following additional
features:
• Extended Tray Preview
• Editing Jobs
• Restarting Jobs
• Resuming Jobs
• Scheduling Jobs
• Exporting Jobs (objzf)
• Modifying the Job Manager Screen
These features are described on the following pages.
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Extended Tray Preview
In this window, you can view the tray from different angles and
magnifications without leaving the Job Manager screen. In addition to
displaying the selected job in the Tray Preview pane, you can open an
enlarged build tray window.

To display the build tray window:
1. Select a job in the Jobs Queue or the History list.
2. Click the Tray Preview pane.

Figure 5-116: Job Preview

• To change the tray magnification, turn the mouse wheel.
• To view the tray from a different perspective, click the relevant icon.
• To resize the window, drag its edge or corners.

If there are several objects on the build tray, you can exclude one or more
from being printed, without actually deleting the object from the tray file.

To prevent the printing of an object on the build tray:
1. Double click on the object you do not want to print.
2. Display the Build tab.
3. Select Exclude from Build.

Figure 5-117: Excluding a model from the build

4. Click Yes to confirm.
On server computers, you can use Tray Preview to dynamically display
objects as they are printed, layer by layer. This enables you to visually
monitor printing progress on the computer screen.

To display printing progress in the Tray Preview pane:
From the Job menu, select Show 3dProgress.

Editing Jobs
You can open jobs in the Jobs Queue for editing.

To edit a job:
1. Select the job.
2. Click the Edit icon .

This option uses additional system resources.
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The Tray Settings screen opens, displaying the build tray. The status of
the job in the Job Manager screen changes to “Editing.”

3. Edit the job.
4. On the Tray Settings ribbon, click .

The status of the job in the Job Manager screen changes back to
“Waiting.”

Restarting Jobs
You can restart jobs from the Jobs Queue and the History list.

To restart a job:
1. Select the job.
2. Click the Restart icon .
The job status changes to “Waiting” (in the Jobs Queue).

Resuming Jobs
If the printing process is stopped or interrupted, you may be able to
continue printing the job from the point where printing stopped.

To resume a job:
1. Select the job.
2. Click the Resume icon .

Scheduling Jobs
You can schedule jobs to be printed at a future time. For example, you can
configure Objet Studio to start long printing jobs in the late evening and
early morning hours.

To schedule a job:
1. Select a job in the Jobs Queue, and click on the pop up toolbar.
2. In the Scheduler dialog box, set the Start Date and Start Time for the job.

Click on the Start Date arrow to open a calendar.

Figure 5-118: Scheduler with calendar displayed

3. Click OK.
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Exporting Jobs (objzf)
You can save print jobs as compressed files.

To export a print job:
1. Select a job.
2. On the pop up toolbar, click .
3. In the Save As dialog box, select a folder.
4. Click Save.

Modifying the Job Manager Screen
You can change the size of the sections of the Job Manager screen, by
dragging the panel edges. This applies to:
• the Jobs Queue panel
• the Time panel
• the History panel
Similarly, you can change the way the screen area is divided between the
main section (Jobs Queue/Time/History) and the panels on the right side of
the screen.
You can collapse (hide) the right panels (Available Resources/Material
Consumption/Tray View) by clicking the top of the panel.
• Click again to display the panel.

For an explanation of objzf files, see “Exporting and Importing Objet Build 
Trays” on page 56.
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Figure 6-1: The Stratasys P750K 3D Printer 

Starting the Printer

1. Turn on the main power switch, located at the back of the printer.

Figure 6-2: Main power switch and cable

Printer cover

Materials cabinet

CAUTION!
Do not attempt to operate the Stratasys printer before being trained by a 
Stratasys customer-support representative.
Observe all safety warnings and follow the safety guidelines described 
in chapter 2.
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2. After the printer control computer boots, log in to Windows and
launch the printer control program:
• On the printer computer desktop, double click the Stratasys printer

icon.
or—
• From the Start menu, select (All) Programs > Objet >Stratasys P750K.

All monitoring and controlling of the printer is done from this interface.

Figure 6-3: Stratasys P750K interface

A HASP plug containing a valid product activation key is required on the 
printer computer. This is installed at the factory or during printer upgrade. If 
the application does not open and a HASP message appears, contact your 
dealer or Stratasys Customer Support.

One monitor displays both the computer running Objet Studio and the 
printer server computer. Make sure that the printer interface is displayed.
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Loading Model and Support Cartridges
Stratasys P750K printers use up to 12 cartridges of Model material and four
cartridges of Support material, each weighing 3.6 kilograms when full. A
graphical representation of the cartridges loaded and their current weight
appears in the printer interface (see figure 6 3).

Important: If you need to replace the Model material currently
installed with another type, see “Changing the Printing Material”
on page 11. Otherwise, make sure to replace the Model cartridge
with one containing the same type of material.

To load Model and Support material:
1. Open the doors of the materials cabinet.
2. Load Model and Support containers into their respective

compartments.
You should feel some resistance, as a needle pierces the cartridge.

3. Check the printer interface to make sure that the new cartridge is
detected and that its weight is displayed (see figure 6 3).

4. Close the materials cabinet.

The materials cabinet uses RFID technology to automatically identify 
cartridges of printing material. For this purpose, an RFID module is built into 
the cabinet. Tampering with this module will render the printer inoperable 
and may void Stratasys warranties and service contracts.

Tips about loading and replacing material cartridges:

You can load partially used cartridges, as long as they contain more than 
100 grams of material.
You can replace material cartridges either before or during printing. 
If printing stops for an extended time before you replace a material 
cartridge, the printer may go into Standby or Idle mode. If this happens, 
see “Resuming Production After Printing has Stopped” on page 9.
You can replace partially used cartridges to avoid the need for replacing 
them during printing.
The cartridge type is automatically detected by the printer. If you replace 
a cartridge containing different Model material, a message appears 
recommending that you run the Material Replacement wizard to flush out 
the old material. 
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Producing Models
The Stratasys P750K printer produces models by printing tray files
prepared in the Objet Studio application and sent to the printer from there.
For information about preparing model files for printing, see “Using Objet
Studio” in this user guide or Objet Studio Help.

Preparing the 
Printer

To prepare the printer for producing models:
1. Make sure that the build tray in the printer is empty and clean. If not,

remove cured material with the scraper, and clean the tray thoroughly
with a wet cleaning cloth.

2. Make sure that there is sufficient Model and Support material loaded,
as indicated in the printer interface (see figure 6 3). You may want to
replace the cartridges of Model and Support material currently loaded
in the printer to avoid the need for replacing them during printing.

Before beginning to produce models, it is recommended that you check the 
current printing quality of the print heads by performing a pattern test (see 
“Pattern Test” on page 25). 

CAUTION: Use protective gloves when cleaning the build tray, and be 
careful of the sharp edges of the scraper blade.

For installing material cartridges and replacing empty ones, see
“Loading Model and Support Cartridges” on page 4.
For changing the type of Model material currently loaded, see
“Changing the Printing Material” on page 11.
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3. cartridgesOn the printer interface, click the red button to switch the
printer to online mode.
The color of the button changes from red to green (see figure 6 4). If
there is a job in the Job Manager queue, it is sent to the printer.

In the printer interface, the printer mode changes from Idle to Pre print, as
the printer’s components prepare themselves for production:
• The print block is heated.
• The UV lamps are powered and they warm up.
When printing begins, Objet Studio sends seven slices to the printer control
application. This is the standard buffer between Objet Studio and the
printer. As each slice is printed, another slice is sent to the printer.
Depending on the size of the model(s) to be produced, printing can take
between several hours to several days. As long as there is enough Model
and Support material in the supply cartridges, printing proceeds
automatically until the job is finished.
The Stratasys P750K printer uses up to six different Model material
cartridges to produce models. In addition, two Support material cartridges
are required. If additional cartridges are installed and they are not needed
for the current print job, the printer interface indicates which are being
used:
• Blue cartridge—used for the print job
• Gray cartridge—not used for the print job
You can monitor printer status indicators by switching the printer interface
display. To do this, click the display toggle button in the printer interface
screen.

Figure 6-4: Printer indicators
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Printer
Interface 
Color Key

The background colors in the printer indicator fields tell you at a glance
whether or not the value or item is suitable or ready for printing.
• Green—suitable/ready for printing

For example, in figure 6 4:
Heads (°C)—The heads have reached the temperature required for
printing models.
Ambient—The ambient temperature of the printing chamber is
within the acceptable range.
Heads Liquid—The level of Model and Support material in the
print block reservoir is OK.
Vacuum—The vacuum level in the system is within the acceptable
range.

• Red—not suitable for printing (or indicates a warning)
For example, in figure 6 4:

Waste—The weight of the waste container is 9000 grams, more than
allowed when beginning a print job. (See “Replacing the Waste
Container” on page 71.)

• Blue—not ready
For example, in figure 6 4:

UV lamps—The UV lamps are not on.
The color of the material cartridges displayed in the printer interface
indicates which cartridges are active for the current (or next) print job.
• Blue—active cartridges
• Gray—reserve cartridges
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Printing
Indicators

The printer interface screen changes when you send a print job from Objet
Studio to the printer, and the printer is on line (see figure 6 5):
• The mode changes from Pre print to Printing.
• The specific activity being performed is shown in the “current activity”

field.
• Current job printing information is displayed.
• The printing progress bar is displayed.
• The Stop and Pause buttons are enabled.
When the weight of a cartridge drops below 100 grams, the display of the
material level in the printer interface is red.

Figure 6-5: Printer interface during printing
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Resuming Production After Printing has Stopped
If the printing process is interrupted, Objet Studio stops sending slices to
the printer. This can happen, for example, if the printing material runs out
in the middle of a print job, and you don’t replace the empty cartridge
immediately. After the printer changes to Standby or Idle mode, you need to
resume printing from the Job Manager screen of Objet Studio.

To continue printing the model:
1. If the printer is in offline mode, switch it to online mode by clicking the

red button at the bottom of the printer interface (see figure 6 3 on
page 3).
The button changes from red to green (see figure 6 4 on page 6).

2. If you don’t know why printing has stopped, make sure that the
connection between the printer and the server computer is active.

3. In the Job Manager screen of Objet Studio, click the Resume icon .
4. In the Continue from Slice dialog box that appears, confirm the slice

number, after checking the printer interface.

Figure 6-6: Printer interface after interrupted printing

Figure 6-7: Continue from Slice confirmation in Objet Studio (Job Manager
screen)

5. If, for any reason, the correct number does not appear in the dialog
box, enter the number and click OK.

After printing stops, the printer goes into Standby mode, when heating of 
print heads is reduced. About 10 hours later, the printer goes into Idle mode, 
when heating of print heads is stopped. 

Printer mode

Last slice printed
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You cannot continue printing the model if:
• The number of the last slice printed does not appear in the printer

interface, even if the server computer displays the Continue from Slice
confirmation dialog box.

• There was a relatively long interruption in printing, even if the “last
slice” and “continue from slice” indicators are correct. The part of the
model already printed may deform or shrink, and there might be a
visible difference between it and the newly printed part. The effects of a
printing stoppage on a model depend on the model size and structure,
Model material used, ambient temperature and the length of the
stoppage.

If you cannot continue printing: 
1. Cancel the print job in the Job Manager screen.
2. Remove the partially printed model from the build tray.
3. Restart the job from the Job Manager screen (in Objet Studio).

You can stop and later resume printing from either the printer interface or 
from the Job Manager screen of Objet Studio. After clicking the Stop button 
on the printer interface, you can resume printing only from the Job Manager
screen. However, after clicking the Pause button in the printer interface, you 
can only resume printing from the printer interface.
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Changing the Printing Material
Before producing models using a different type of printing material than is
currently installed, run the Material Replacement wizard to flush the print
block and feed tubes.

To replace the printing material with the wizard:
1. Start the Material Replacement wizard from the Options menu.

Figure 6-8: Starting the Material Replacement wizard

2. In the opening screen, click Next.

You should carefully plan printing models with different Model materials to 
avoid unnecessary waste of the materials currently loaded. The amount of 
material flushed depends on the flushing cycle chosen and if you are 
replacing one or more Model cartridges. 

The Material Replacement wizard suggests the best slot locations for 
placing different material cartridges, based on materials currently in the 
system. This ensures minimum flushing of materials currently loaded.
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3. If the printer cover is not closed, a screen appears, prompting you to
close the cover. Confirm that it is closed and click Next.

4. Choose the configuration for producing models:
• 6 materials
• 3 materials

5. In the Required materials section of the wizard screen, select one or more
replacement materials.

6. Select Both cartridges if you need to load two replacement cartridges.
Loading one replacement cartridge is more economical because it
potentially requires less flushing of material currently in the system.
However, when one cartridge is not sufficient, loading two cartridges
enables continuous printing until the print job is completed. When one
cartridge empties and the other one is being used, you can replace the
empty cartridge with a new one.

6 materials
Each of the Model materials is loaded into a separate chamber in the
print heads.

You can print with any of the loaded materials without the need to
run the wizard.

3 materials
Two chambers in each of the three Model print heads are used for each
Model material.

This mode is required to produce build trays at high speed, using up
to three Model materials.
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7. Choose how thoroughly you want to flush out material currently in the
system:
• Economy. This cycle can be used when replacing a light colored

Model material with a darker material (such as TangoBlack™ or
VeroBlack™), or if the exact color of the printed models (in the first
print jobs) is unimportant.
The wizard flushes the system with the minimum amount of
material needed to ensure that models have the mechanical
properties of the new material.

• Full. Use this cycle when the printed models must have the exact
color of the new material.
The wizard thoroughly flushes the feed tubes and print heads
needed for printing, based on your selections in the previous
screens.

8. Click Next to begin the material replacement process in the printer.

The Cartridge positioning screen appears, showing you the new location
of all cartridges in the materials cabinet.

Figure 6-9: Cartridge placement

Symbols:
The correct cartridge is in this slot.
No cartridge (or the incorrect cartridge) is in this slot.
The cartridge in this slot has insufficient weight to complete the
material replacement process.
The expiration date of the cartridge in this slot has passed.

9. Replace material cartridges, as necessary, according to the instructions
in the wizard screen.

10. Click Start.

There are additional settings that you can select for special purposes (see 
Advanced Settings). If necessary, click Advanced Settings before clicking 
Next.
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11. Read the warning message, and click OK.

Figure 6-10: Final wizard screen

12. Click Done to close the wizard.
The printer control application is automatically updated, and the
interface displays the new material(s). The Objet Studio application (on
the printer server computer) is also updated and displays the new
material(s).

13. Inspect the area around the purge unit and clean it, if necessary.

Advanced 
Settings

The Advanced Settings dialog box enables you to configure the Material
Replacement wizard for special purposes. If necessary, click Advanced 
Settings in the Material Replacement Options screen before clicking Next.

Figure 6-11: Advanced Replacement settings

If you continue, you must complete the material replacement process 
before you can produce models. To replace material  at another time, click 
Cancel. If you continue (by clicking OK) and you do not complete the 
process, you will need to run the wizard again before producing models. 

CAUTION: Dispose of all material cartridges in accordance with all 
applicable laws and regulations. If necessary, the cartridges can be 
disassembled for recycling. If this is done, protect the person handling 
the cartridges from direct exposure to uncured resins.
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Positioning By default, Automatic slot selection determines the best slot locations for the
cartridges in the materials cabinet, based on materials currently in the
system. This ensures minimum flushing of materials currently loaded. If
there is a special need to load cartridges in certain slot locations, select
Manual slot selection.
After clicking Apply, the Material Replacement Options screen appears, but
now, each material selection box corresponds to one of the cartridge levels
in the materials cabinet.

Figure 6-12: Manual cartridge placement

Flush Again The flushing cycle you select in the Material Replacement Options screen
determines how thoroughly to flush out material currently in the system.
After selecting the Economy cycle and completing the wizard, you might
decide that you require a more thorough flushing, to ensure accurate
model color. Or, you may notice that printed models are not satisfactory
because they contain traces of the previous material. If so, you can flush out
more material, so that the next models will be printed with pure material.
After selecting the “flush again” option and clicking Apply, the Material
Replacement Options screen appears, where you select the affected
material(s) to be flushed.

Note: Select only the materials you need to flush.
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Keeping the Printer in Idle Mode
Between printing jobs, the Stratasys P750K printer can be kept on for up to
one week. If the printer will not be used for more than a week, use the
Shutdown wizard to automatically perform the procedures that must be
done before turning off the printer (see “Shutting Down the Printer,”
below).
When the printer stops producing models, the printer software
automatically reduces the temperature of the print heads as follows:

Note: The printer mode is indicated in the green field on the left of the 
interface (see figures 6-3, 6-4 and 6-5 on pages 3, 6 and 8).

If, after printing a job, you know that the printer will not be used for 10
hours or more, you can immediately turn off the heating of the print heads
by putting the printer into Idle mode.

To put the printer into Idle mode:
From the File menu (in the printer interface) click Exit.

Note: The printer remains in Idle mode until you open the Stratasys printer 
application and begin printing again.

Time after printing Mode Change in heating of print heads

first 15 minutes Standby 1 none

next 10 hours Standby 2 heating reduced (to room temp.)

after 10 hours Idle heating stopped

When the printer is in Idle mode, do not turn it off. It can remain in this 
mode—with the cover closed—for up to a week. For longer periods, shut 
down the printer by running the Shutdown wizard (see below). 
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Shutting Down the Printer
You only need to shut down the Stratasys printer if it will not be used for a
week or more. Otherwise, the printer can remain on, in Idle mode.

To properly shut down, the printer needs to perform several processes.
These are controlled by the Shutdown wizard. Do not attempt to shut
down the printer by simply closing the computer interface (the printer
control application), and never disconnect power to the printer before
completing this wizard.

Depending on the length of time the printer will not be used, you can
choose between a short shutdown procedure, and a more thorough
procedure.
• Up to 30 days: The wizard empties the print block of Model and

Support material, to prevent leaks. This takes about 10 minutes.
• More than 30 days: The wizard empties the print block, then flushes

the system with cleaning fluid. This takes up to 75 minutes, and you
must be present to load cleaning fluid cartridges when instructed.

To run the Shutdown wizard:
1. Start the Shutdown wizard from the Options menu.

Figure 6-13: Shutdown wizard, opening screen

2. Click Next.

The Shutdown process flushes printing materials from printer components. 
To avoid flushing out valuable material, make sure to print models at least 
once a week. Many printer operators use this opportunity to print customer 
samples or test models.

CAUTION: Not using the printer for an extended period without first 
running the wizard can cause serious damage to print heads and other 
expensive printer parts.
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3. Choose the appropriate option for the length of time that the printer
will not be used—less or more than 30 days.
Note: Before selecting More than 30 days, make sure that cleaning-fluid  
are available.

Figure 6-14: Shutdown options

4. In the next screen, verify that the tray is empty and click Next.
The shutdown procedure begins.

Figure 6-15: Shutdown progress screen

Figure 6-16: Final Shutdown wizard screen

5. After the printer computer shuts down, turn off the main power switch
at the back of the printer.
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Maintaining the Printer
The performance of routine maintenance tasks is essential for getting
satisfactory results from Stratasys 3D printers. Perform the tasks at
specified intervals for optimum performance.

Routine 
Maintenance
Schedule

Frequency Task For More Information

Before / after printing Check UV lamp
overheating indicator.

See “UV Lamp Check”
on page 20.

Before / after printing Clean the print heads
and the roller surface.

See “Cleaning the Print
Heads and the Roller”
on page 20.

Daily Clean and inspect the
wiper.

See “Cleaning and
Replacing the Wiper”
on page 23.

Weekly Perform the Pattern test. See “Pattern Test” on
page 25.

Weekly—when printing
with MED610

Calibrate the UV
intensity.

See “Testing and
Calibrating the UV
Lamps” on page 53.

Weekly Clean the roller waste
collector.

See “Cleaning the Roller
Waste Collector and
Inspecting the Roller
Scraper” on page 27.

Every 300 hours of
printing (A reminder
message appears.)

Calibrate the UV
intensity.

See “Testing and
Calibrating the UV
Lamps” on page 53.

Every 300 hours of
printing (A reminder
message appears.)

Optimize the print
heads.

See “Optimizing
(Calibrating) Print
Heads” on page 35.

Monthly, and after
replacing print heads

Check the alignment of
the print heads.

See “Aligning the Print
Heads” on page 32.

Monthly Restart the printer
computer.

Monthly Inspect the exhaust
system (duct, fan,
connections).

Monthly Calibrate the load cells. See “Calibrating the
Load Cells” on page 59.

Every 3500 hours of
printing or every two
years

Preventive maintenance
visit by authorized
service engineer.

Contact your Stratasys
service provider.
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UV Lamp 
Check

A heat sensitive label is fixed to the UV lamp covers as a warning against
overheating. Its center changes from white to black if the temperature of
the cover reaches 65 °C (150 °F). If this occurs, do not use the printer, and
call your service provider. As a precaution, it is recommended that you
check the label before and after printing.

Figure 6-17: Heat-sensitive label on UV lamp cover

Cleaning the 
Print Heads 
and the Roller

Periodic inspection and cleaning of the orifice plates on the bottom of the
print block ensures that the print nozzles are not clogged. A wizard guides
you through the procedure, and adjusts components of the printer to
enable you to perform it. This procedure takes about 20 minutes, and
should be done at the beginning of the work day or before a big printing
job.

To clean the print heads and the roller:
1. Prepare—

• isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
• disposable cleaning gloves
• a supplied cleaning cloth or equivalent
• a mirror

2. Start the Head Cleaning wizard from the Options menu (see figure 6 22
on page 23).

Normal

Overheating 
problem

If the UV lamp continues to overheat, and the temperature around the lamp 
reaches 90 °C (194 °F), a heat fuse cuts the power to the UV lamp and the 
motion motors. In the unlikely event that this occurs, the printer cannot be 
used until it is serviced by an authorized service engineer.
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3. Follow the instructions on the wizard screens, and select the
confirmation check boxes.

Figure 6-18: Head cleaning procedure—wizard screen

4. Click Next.
The printer prepares for you to clean the print heads.

5. When the following screen appears, open the cover.

Figure 6-19: Head cleaning wizard—steps 5–11

6. Place the mirror on the build tray.
7. Put on the gloves.

8. Soak the cleaning cloth with alcohol.

WARNING:  The print head orifice plates (bottom surface) might be hot, 
so proceed with caution.

CAUTION: Uncured printing material on the print heads might cause 
skin irritation. Use disposable cleaning gloves to protect your hands.
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9. Clean the orifice plates, with a back and forth motion (see figure 6 20).
Use the mirror to make sure that you have removed all of the residue
material.

Figure 6-20: Cleaning the heads

10. Clean the entire roller surface, by rotating it as you clean.

11. When you have finished cleaning, select the confirmation check boxes
in the wizard screen (see figure 6 19) and click Next.

12. Remove the cleaning materials from the printer and close the cover.
13. Select the confirmation check boxes in the wizard screen and click

Next.
The head purge cycle begins. When this is complete, the final wizard
screen appears.

Figure 6-21: Head-cleaning wizard—final screen

14. Click Done to close the wizard.

Use this opportunity to clean the glass lens on the UV lamps.
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Cleaning and 
Replacing the 
Wiper

A rubber wiper removes excess material from the print heads after the
purge sequence. This is done automatically before each print job, and
performed manually during maintenance tasks. You should clean the
wiper and surrounding area at least once a week. If the wiper is damaged
or worn, replace it.

To inspect and clean the wiper:
1. Prepare—

• isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
• disposable cleaning gloves
• the supplied cleaning cloth or equivalent
• a spare wiper

2. Start the Wiper Cleaning wizard from the Options menu.

Figure 6-22: Starting the Wiper Cleaning wizard

3. In the opening wizard screen, click Next.
4. Make sure that the build tray is empty, and close the printer cover.

Confirm this in the wizard screen and click Next.

Figure 6-23: Wiper Cleaning procedure—step 4
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5. When the following screen appears, open the cover.

Figure 6-24: Wiper Cleaning wizard during steps 6–10

6. Put on the cleaning gloves.
7. Using a generous amount of alcohol on the cleaning cloth, remove any

material remaining on the wiper and the surrounding area.
8. Remove any pieces of waste material collected in the purge unit. If

necessary, remove the waste collector to clean it. Wipe the rubber seal.

Figure 6-25: Purge unit waste collector

Note: When returning the waste collector to the purge unit, make sure to 
insert it as shown.

9. Inspect the wiper.
If the wiper is scratched, torn or worn, or if you cannot clean it
completely, replace it.
a. Grasp it and pull it up and out of its bracket.
b. Insert the new wiper blade, making sure that it is straight and secured

well on both sides.
10. In the wizard screen (see figure 6 24), confirm that the wiper blade is

clean, and click Next.
11. Remove all tools and cleaning materials from the printer, and close the

cover.
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12. Confirm this in the wizard screen, and click Next.

Figure 6-26: Confirmation screen

13. Click Done to close the wizard.

Pattern Test The pattern test is the basic verification of the printer’s ability to produce
quality models, since it demonstrates the condition of the nozzles in the
print heads. Make sure, therefore, that you perform this test weekly, and
whenever you suspect a printing problem.

To perform the pattern test:
1. Make sure that the build tray is empty.
2. Prepare a sheet of pink paper—A 4 or Letter size.
3. In the printer, tape the pink paper to the surface left of the build tray.
4. Press F3, or open the Options menu and select Pattern Test.

Figure 6-27: Pattern Test confirmation

5. If the build tray is not clear, click No in the following dialog box.
This lowers the build tray, so that models on the tray are not damaged.

Figure 6-28: Build tray (Z) level adjustment

The printer prints a series of lines on the test paper (see next figure).
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Figure 6-29: Sample Pattern Test

6. Carefully inspect the test paper to see if there are missing lines.
Too many missing lines, especially if they are in the same area,
indicates that the quality of printing when producing models will be
poor. If this is the case, see “Improving Print Quality,” below.
Note: Acceptable model quality is subjective, and depends on the type 
and scale (size) of the models produced. As a rule, however, more than 10 
missing lines in one area of a column is considered unacceptable.

Improving 
Print Quality

If you suspect that print quality is poor, perform the pattern test (see
“Pattern Test” on page 25). If the results are poor, use the following
procedure to improve print quality.

If the results of the last pattern test are poor:
1. From the Options menu, select Purge Sequence, or press F4.
2. In the confirmation dialog box, click Yes.

The print heads are purged of Model and Support material, and the
wiper removes excess material from them.

3. Repeat the purge sequence.
4. Perform the pattern test.

If the results of the pattern test are still poor:
1. Manually clean the print heads (see “Cleaning the Print Heads and the

Roller” on page 20).
2. Perform the purge sequence.
3. Perform the pattern test.

If the results of the pattern test are still poor:
1. Carefully clean the print heads again, making sure there is no residue

left on them.
2. Perform the purge sequence.
3. Perform the pattern test.

If the results of the pattern test are still poor:
Optimize the print heads and replace faulty print heads, if necessary
(see “Optimizing (Calibrating) Print Heads” on page 35).
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Cleaning the 
Roller Waste 
Collector and 
Inspecting the 
Roller Scraper

The roller waste collector removes waste material scraped from the roller.
Suction removes this waste to the printer’s waste container.
This assembly should be cleaned weekly to prevent a blockage in the tubes
leading to the waste container, so that waste material does not overflow
into the printer.

To clean the roller waste collector:
1. Prepare—

• M2.5 and M2 Allen® keys
• disposable cleaning gloves
• isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
• cleaning cloth
• cotton swabs (Q tips or similar)

2. Put on the gloves.
3. Remove the right UV lamp assembly:

a. Disconnect the UV power cable and the fan power cable.

Figure 6-30: Disconnecting the right UV assembly

b. Remove the screw that secures the right UV lamp, and then pull and
lift up the UV lamp.

Fan power 
connector

UV Power 
connector

Screw
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4. Loosen the two screws securing the suction tube on the print block.

Figure 6-31: Lifting the suction tube

5. Lift the suction tube to secure it in a raised position.
6. Remove the two screws securing the covering of the roller waste

collector and remove it.

Figure 6-32: Removing the roller waste collector covering

7. Remove the covering by pulling it out, and then lower it.
8. Clean the roller waste collector and the scraper blade surface using

cotton swabs. Make sure to remove any remaining printing materials.

Figure 6-33: Cleaning the roller waste collector

Suction tube screws

Be very careful to save the covering screws. These are special screws; if 
they are lost, you need to order replacements.

Roller waste 
collector screws

Before replacing the covering, you can check the effectiveness of the roller 
scraper—see below.
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To check the effectiveness of the roller scraper:
1. Put on the cleaning gloves.
2. Wet a cloth with isopropanol.
3. Use the cloth to wet the bottom of the roller.
4. Turn the roller slowly with your hand. As the blade scrapes the roller,

make sure the isopropanol is spread evenly over the entire length of
the blade.

5. Inspect the roller. If it is not dry, replace the blade. (See “Replacing the
Roller Scraper” on page 30.)

6. Before returning the roller waste collector to the print block, make sure
that the pins are clean.

Figure 6-34: Roller waste collector pins

To re-assemble the components:
1. Return the roller waste collector to the print block and screw on the

covering (see figure 6 32 on page 28).
2. Loosen the screws securing the suction tube.

Figure 6-35: Suction tube correctly positioned

3. Lower it so that the hole in the panel behind the suction tube is visible,
and tighten the screws to secure the tube.

4. Attach the right UV lamp assembly to the print block and reconnect
the UV power and fan cables.

Roller waste 
collector pins

Securing screws
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Replacing the 
Roller Scraper

You should replace the roller scraper blade—
• after 1,000 hours of printing.
• if it does not effectively keep the roller clean.

To replace the roller scraper:
1. Prepare—

• a new roller scraper blade (KIT 01026 S)
• a Phillips 1x75 mm screwdriver
• M2.5 and M2 Allen® keys

2. Remove the right UV lamp and the roller waste collector covering (see
steps 3 to 6 on page 27.)

3. Loosen the two screws securing the roller waste collector and pull it
out.

Figure 6-36: Removing the roller waste collector

4. Remove the screws that secure the roller scraper assembly.

Figure 6-37: Removing the roller scraper screws

You should periodically test the effectiveness of the roller scraper when you 
clean the roller waste collector. See “Cleaning the Roller Waste Collector 
and Inspecting the Roller Scraper” on page 27.
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Figure 6-38: Removing the old roller scraper blade

5. Remove the scraper blade and discard it.
6. Place the new scraper blade onto the pins in the holder, as shown.

Figure 6-39: Inserting the new roller scraper blade

7. Insert and tighten the roller scraper blade screws.

Figure 6-40: Tightening the roller scraper screws

Important:

Tighten the screws in the order shown in figure 6-40.
Use the new screws supplied in the replacement kit.
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8. After tightening the screws, inspect the blade and make sure that it is
straight. If necessary, loosen the screws and tighten them again, evenly.

9. Return the roller waste collector assembly and the right UV lamp to
the print block. See steps 6 to 4, from page 29.

Aligning the 
Print Heads

You should check the alignment of the print heads—
• once a month
• after replacing one or more heads
• if model quality is not acceptable even after cleaning the orifice plate on

the bottom of the print block (see “Cleaning the Print Heads and the
Roller” on page 20)

This procedure takes about 20 minutes.

To check the alignment of the print heads:
1. Prepare—

• a transparency sheet—A 4 or Letter size
• any type of sticky tape, to fasten the transparency sheet to the build

tray
2. Start the Head Alignment wizard from the Options menu (see

figure 6 8 on page 11).
3. Click Next to begin, and close the cover.
4. In the wizard screen, select the check box to confirm that the cover is

closed, and click Next.
5. When instructed to do so, place the transparency on the build tray—

next to the left and rear edges of the tray, as shown in the following
figure.

Figure 6-41: Positioning the transparency on the build tray

6. Make sure that the transparency sheet is lying flat, and tape it to the
tray.

7. In the wizard screen, select the check box to confirm that the
transparency sheet is on the build tray, and click Next.
The printer prints the head alignment test on the transparency.
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8. When the following screen appears, remove the transparency.

Figure 6-42: Head Alignment wizard—steps 8–10

The transparency sheet is printed with sets of vertical lines in seven
columns, each showing the results from a different print head.

Figure 6-43: Sample head-alignment test

Note: There is no column for head H7 because its alignment is used as a 
reference for aligning all other heads.

9. For each column of lines, use a magnifying glass or loupe to inspect
pairs of consecutive rows printed on the transparency to see where the
vertical lines align.

Figure 6-44: Comparing rows of alignment lines

Note: It does not matter which pair of lines you inspect, since they were all 
printed by the same head. Choose a pair of clearly printed lines for the 
inspection. (Since some nozzles may not print clearly, you may have to 
inspect several pairs of lines to properly view the alignment.)
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Optimum head alignment is shown when the fourth lines in the upper
and lower rows are aligned, as in figure 6 44. In the example shown, no
change to the head alignment is necessary. If other lines in the set are
aligned, you need to change the alignment of that head—in the next
wizard screens.

10. In the wizard screen shown in figure 6 42, select the Transparency
removed check box, and click Next.
The first in a series of alignment screens appears.

Figure 6-45: Head alignment screen

11. In the head alignment screen, select the number that indicates which
lines align in the upper and lower rows of a pair on the transparency
(counting from the left) for this print head.
Note: Because the alignment of the fourth lines is optimum, the number “4” 
is selected, by default, in the wizard screen. This does not change the head 
alignment. If you select other numbers, the wizard adjusts the head 
alignment, accordingly.

12. Click Next to display the next head alignment screen, and again select
the number representing the most closely aligned vertical lines on the
transparency for that print head.
When you have finished aligning all of the heads, the following screen
is displayed.

Figure 6-46: Parameter update confirmation
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13. Continue as follows:
• To make the alignment changes in the printer, make sure that Yes is

selected, and click Next.
• To recheck the alignment test results before making the alignment

changes in the printer, click Previous.
• If you do not want to make alignment changes in the printer at this

time, select No and click Next.
14. In the following screen, you can choose to either repeat the head

alignment procedure or close the wizard.
• If the most closely aligned vertical lines for a print head were at

either extreme—the first or seventh lines—choose Repeat the test,
then click Next.
The transparency test will show if the heads are now properly
aligned, and—if not—the wizard will allow you to “fine tune” the
alignment.

• If the vertical lines for the print heads were not aligned at either
extreme, choose End the wizard, then click Next.

Figure 6-47: Repeat head alignment option

Optimizing
(Calibrating) 
Print Heads

The condition of the print heads directly affects the quality of printed
models. To maintain optimum printing, you should routinely test the print
heads and calibrate them to the best working configuration possible. To do
this, run the Head Optimization wizard every 300 hours of printing.
During this procedure, you place a scale on the build tray and connect it to
the printer. The weights of printed samples are analyzed by the wizard to
determine how to optimize the print heads.
If, during the optimization process, the wizard determines that a print head
is faulty—or that it is negatively affecting layer uniformity with the current
head configuration—the wizard instructs you to replace it. If this happens,
you have the option to replace the print head or to abort the wizard and
replace the head at another time.

Run the Head Optimization wizard whenever the condition of print heads is 
negatively affecting the quality of printed models, or if you suspect that there 
is a problem with one or more of the print heads.
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Note: To accurately test and calibrate print heads, they must be clean. If 
necessary, run the Head Cleaning wizard before beginning this 
procedure.

To test and calibrate the print heads:
1. Prepare—

• disposable cleaning gloves (any clean, powder free protective
gloves)

• pink paper
• the Missing Nozzles ruler
• the scale supplied for use with this wizard

Note:Ensure that the scale is calibrated and charged before beginning 
this procedure.

2. Start the Head Optimization wizard from the Options menu.

Figure 6-48: Starting the Head Optimization wizard

3. In the opening wizard screen, click Next to begin.
The Wizard Conditions screen appears.

4. Read the conditions, select I Agree and click Next.
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5. In the following screen, select Continue with Head optimization if you
have recently cleaned the print heads. Otherwise, cancel the wizard
and run the Head Cleaning wizard.

Figure 6-49: Clean print heads screen

6. In the following screen, make sure Optimize all print heads is selected
and click Next.

Figure 6-50: Procedure selection screen

7. Select the printing mode for which you want to optimize the print
heads and click Next.

Figure 6-51: Printing mode selection
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8. When the following screen appears, tape a sheet of pink paper to the
surface left of the build tray, close the cover and click Next.

Figure 6-52: Preparations confirmation

The printer prints a frame on the build tray and then prints the Pattern
Test.

9. When the Pattern Test is printed, carefully inspect it, using the Missing
Nozzles Ruler to see if there are missing lines.

Figure 6-53: Inspecting the Pattern Test

Each missing line represents a faulty nozzle in the print head.
10. In the following wizard screen, enter the number of missing nozzles

for each print head and click Next.

Figure 6-54: Enter Missing Nozzles screen



DOC08010 Rev. A (DRAFT 1) 6–39

Stratasys P750K User Guide

11. The wizard continues according the number of missing nozzles you
entered.

If there are too many missing nozzles for acceptable printing, the
wizard instructs you to replace the defective print head(s). You can
do this now, or abort the wizard.
If you are prepared to replace print heads now, the wizard guides
you through the procedure when you click Next. Make sure you
have replacement heads and the required tools (see page 42).
Continue with “Preparing the Print Block” on page 44.

Figure 6-55: Head replacement due to missing nozzles

If the number of missing nozzles in all print heads is acceptable, the
wizard continues with the head optimization process (below).

12. Set up the scale in the printer by performing the steps listed in the
wizard screen.

Figure 6-56: Setting up the Head Optimization scale
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13. After confirming all of the items listed in the wizard screen, click Next.
Printing material (resin) is jetted from each head and its weight is
automatically recorded. This process is repeated for each printing
mode, after which the following screen appears.

Figure 6-57: Emptying the Resin Container

14. Carefully remove the resin container from the scale and empty it into
the purge unit in the printer. Then return the container to the scale.

15. Close the printer and click Next.
The printer cures the remaining resin in the container.

16. When the following screen appears, remove the scale and clean the
build tray.

Figure 6-58: Removing the Scale confirmation screen

The wizard uses the data collected to analyze the condition of the print
heads and optimize them so they print models with a uniform layer of
material.
• If the heads are in satisfactory condition, the following wizard screen

appears.

CAUTION: The resin in the container is uncured. 
To prevent contact with skin, wear neoprene or nitrile gloves. 
Dispose of uncured resin in accordance with applicable regulations. By 
emptying the container into the purge unit, the resin is stored in the 
printer’s sealed waste container.
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Figure 6-59: Final wizard screen, after optimizing print heads

• If the wizard determines that a print head is faulty—or that it is
negatively affecting model quality with the current head
configuration—you need to replace it. Indicate whether or not you
want to do so now.

Figure 6-60: Defective print heads found

Choose Replace defective head(s) if you are prepared to replace the
print heads now (see below).
or—
Choose Abort wizard if you want to replace the print heads at another
time.

Replace print heads only after consulting with a Stratasys-authorized 
customer-support engineer.
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To replace print heads, you need these tools and materials:
• replacement print head(s)
• isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
• disposable cleaning gloves (supplied with the print head; or use

any clean, powder free protective gloves)
• a supplied cleaning cloth or equivalent
• a mirror
• a 5 mm flat head screwdriver or a 3 mm hex (Allen®) key,

depending on the type of print block
• the scale supplied for use in the Head Optimization wizard (Weight

Test)
• the Missing Nozzles ruler

If you are replacing print heads now, the wizard guides you through the
procedure when you click Next. Continue with “Preparing the Print Block”
on page 44.

Replacing 
Print Heads

The condition of the print heads directly affects the quality of printed
models. You may need to replace a print head if one or more of the
following symptoms occurs:
• The Head Optimization wizard determines that a print head is

defective. (See “Optimizing (Calibrating) Print Heads” on page 35.)
• There are noticeable grooves in the surface of printed models.
• Visual inspection of the head reveals that its surface is damaged—

peeling or bubbles in the nozzle area.
• The printer interface displays a warning or malfunction message

relating to a print head—
Head Heater temperature timeout
Head Heater thermistor open
Head Heater thermistor short

Replace print heads only after consulting with an authorized customer-
support engineer.
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The Head Optimization wizard guides you through the procedure of
replacing a print head and adjusts printer components to enable you to
perform it. Only replace a print head with the aid of the wizard. The entire
procedure takes about 45 minutes, and consists of the following phases:
A. Identifying the head(s) needing replacement.

This is normally done by the Head Optimization wizard. Otherwise,
evidence of physical damage to the head surface or a malfunction
message indicates which head needs replacing.

B. Preparing the print block for head replacement.
This is done automatically when you run the wizard.

C. Removing the defective print head.
D. Installing a new print head.
E. Optimizing the print heads (done automatically by the wizard).
F. Performing head alignment.

To replace a print head:
1. Prepare—

• replacement print head(s)
• isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
• disposable cleaning gloves (supplied with the print head; or use

any clean, powder free protective gloves)
• a supplied cleaning cloth or equivalent
• a mirror
• a 5 mm flat head screwdriver or a 3 mm hex (Allen®) key,

depending on the type of print block
• the scale supplied for use in the Head Optimization wizard (Weight

Test)
• the Missing Nozzles ruler
Note: Make sure that you have these items and that the scale is calibrated 
and charged before continuing.

2. Start the Head Optimization wizard from the Options menu (see
figure 6 48 on page 36).

3. In the opening wizard screen, click Next to begin.
The Wizard Conditions screen appears.

4. Read the conditions, select I Agree and click Next.
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5. In the following screen, select Continue with Head optimization if you
have recently cleaned the print heads. Otherwise, cancel the wizard
and run the Head Cleaning wizard.

Figure 6-61: Clean print heads screen

6. In the following screen, select Replace faulty heads and click Next.

Figure 6-62: Procedure selection screen

Preparing the
Print Block

7. Select the print head(s) needing replacement and click Next.

Figure 6-63: Head selection screen
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The printer heats and empties the print block and prepares the printer.
(This can take up to 15 minutes.)

Figure 6-64: Printer preparation progress screen

8. The following screen appears when the printer is ready for you to
replace print heads.

Figure 6-65: Printer ready for head replacement

9. Put on the protective gloves and open the printer cover.
Note: The printer disconnects power to the heads for your safety.
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Removing the
Defective Head

10. On the print block, release the upper and lower screws that secure the
print head in the block. (If necessary, you may use a screwdriver to
loosen the screws.)

Figure 6-66: Releasing the locking screws

11. Press down on the upper and lower locking screws to release the print
head.

Figure 6-67: Releasing the print head

12. Loosen the screws on the door of the compartment protecting the
print head driver cards (A), then pull and lift up the door (B).

Figure 6-68: Opening the print-head compartment
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13. Pull the print head driver card out of its socket so that the head is free
(A) and remove it from the bottom of the print block (B).

Figure 6-69: Releasing the print-head driver card to remove the head

14. Make sure that along with the head, you remove the two rubber O ring
seals.

Figure 6-70: O-ring seals on the print head

Figure 6-71: Making sure the O-rings are not stuck to the print block

Important: If the seals are not removed with the head, they are probably 
stuck to the print block housing. If so, remove them.
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Installing the
New Head

15. Inspect the replacement head and make sure that the O ring seals are
in place (see figure 6 70).

16. Gently insert the replacement head into the vacant slot in the print
block and push the print head driver card into its socket.
Note: Make sure to insert the head with the driver card facing its socket, in 
the rear of the print block.

Figure 6-72: Inserting the print-head driver card into its socket

17. Push the head up until you hear it click into place, in both front and
rear holders.

Figure 6-73: Clicking the head into place in the print block

18. Lower the door of the print head compartment and tighten the screws
to lock it in place.

19. Tighten the upper and lower screws that secure the print head in the
print block (see figure 6 66 on page 46).
Note: Hand-tighten these screws. Do not use a screwdriver.
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20. In the Replace print heads screen, select the check box to confirm that
you have replaced the head(s) and click Next.

Figure 6-74: Head replacement confirmation

21. With your fingers, make sure that the new head is level and even with
the other heads.

Figure 6-75: Checking the level of the new head

22. Confirm that the heads are level and even by selecting the check box in
the following wizard screen and click Next.

Figure 6-76: Installation-check screen
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23. In the next wizard screen, confirm that you have removed all tools and
objects from the printer.

Figure 6-77: Cleared-tray confirmation screen

24. Close the printer cover.
The wizard continues by heating the heads, then filling and purging them.
If there are no installation problems, the optimization procedure begins, to
calibrate the print heads to the best working configuration—see
“Optimizing (Calibrating) Print Heads” on page 6 35.
If installation problems are detected, the wizard alerts you and instructs
you how to continue (see “Installation Problems,” next).
After replacing print heads, you should check the head alignment before
using the printer to produce models. In the final wizard screen...

Select Yes and click Done to open the Head Alignment wizard (see
“Aligning the Print Heads” on page 32).
Select No and click Done to align the heads at another time.

Figure 6-78: Final wizard Screen
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Installation
Problems

If the printer detects that there is a problem after you install print heads,
relevant warning screens appear.
• If the printer software does not detect the replaced head, the following

warning screen appears.

Figure 6-79: Incorrect-installation screen

If this happens:
a. Open the print head compartment (see figure 6 68 on page 46).
b. Re insert the print head driver card into its socket (see figure 6 72

on page 48).
c. In the wizard screen, select the check box to confirm that you have

re inserted the card and click Next.
• If the replacement head was not factory calibrated, the following

warning screen appears.

Figure 6-80: Invalid-data warning screen

If this happens:
a. Remove the head and replace it with another one (starting with

step 10 on page 46).
b. In the wizard screen, select the check box to confirm that you have

installed another print head and click Next.
c. Contact your authorized Customer Support center about the

unformatted head.
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• If the vacuum test is not successful, the replacement head was not
sealed properly during installation, and the following warning screen
appears.

Figure 6-81: Vacuum-leakage warning screen

If this happens:
a. Click Next.
b. Follow the instructions on the wizard screens to re install the head.
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Testing and 
Calibrating the 
UV Lamps

The effective UV radiation from the lamps used for curing models can
change over time. To ensure optimum curing of models during printing, a
pop up message reminds you to test the lamps and calibrate their effective
UV radiation after every 300 hours of printing. You do this by running the
UV Calibration Wizard.
To measure the UV radiation, you need:
• Stratasys TOL 03005 S (UV sensor and cable, supplied with the printer)

or—
• a stand alone UV radiation meter, approved for use with the printer
The wizard compares the measured radiation to the recommended
radiation level for each of the lamps, at each printing mode—High Speed,
High Quality and Digital Material.
When calibrating the lamps, the wizard attempts to adjust the radiation
level, if necessary.
• If the reading is within the acceptable range, the wizard continues to

the next phase.
• If further adjustment is necessary, the current phase is repeated.
• If the UV radiation is too low to be properly adjusted, the wizard

continues to the next phase, but the final wizard screen indicates that
the lamp’s radiation for the printing mode is unacceptable.

To test and calibrate UV lamp radiation:
1. Start the UV Calibration Wizard from the Options menu (see figure 6 22

on page 6 23).
2. In the following screen, select Calibrate UV Intensity to adjust the lamp’s

radiation level to the acceptable range.

Figure 6-82: UV Test/Calibration selection

Before testing and calibrating the UV lamps: 

Make sure the glass lens on each of the UV lamps is clean. For easy 
access, run the Head Cleaning Wizard, and use the special cleaning pad 
supplied.
Make sure that the glass over the UV radiation sensor is clean.
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3. In the following screen, select the UV sensor and measuring device to
be used.

Figure 6-83: UV device selection

4. Make sure that the build tray is clear (empty), confirm this in the
wizard screen and click Next.

Figure 6-84: Printer preparation

When using the Stratasys UV sensor (TOL 03005 S), continue with
“UV sensor connected to printer,” below.
When using a stand alone radiation meter, continue with “External UV
meter” on page 57.

UV Measuring Device 

When you use the Stratasys UV sensor (TOL-03005-S), you connect it to the 
printer. The wizard automatically measures and calibrates the UV radiation.

If you use a stand-alone UV radiation meter, you need to manually enter the 
readings from the meter in the wizard screens.
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The following steps apply when using the Stratasys UV sensor that you 
connect to the printer (TOL-03005-S). They do not apply when using a 
stand-alone UV radiation measuring device.

UV sensor
connected to printer

1. Adjust the wizard for the sensitivity of the UV sensor by entering the
CF number that appears on the sensor’s label.

Figure 6-85: UV sensor synchronization

Figure 6-86: Label on the bottom of the UV sensor

The build tray lowers so you can connect the UV sensor.

Figure 6-87: UV sensor connector
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2. Connect the UV sensor cable to the connector in the printer.

Figure 6-88: Sensor preparation

3. Confirm the items listed in the wizard screen and click Next.

Continue with “UV measurement” on page 58.
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External UV meter The following steps apply when using a stand-alone UV meter. They do 
not apply when using the Stratasys UV sensor connected to the printer.
1. When the following screen appears, open the printer and place the UV

sensor at the rear edge of the tray, in the center.

Figure 6-89: Sensor placement screen

Figure 6-90: Correct UV-sensor placement

2. Lead the cable out of the printer so that you can close the printer, and
make sure that the cable will not interfere with the moving print block.

3. Close the printer, while checking that the sensor does not move out of
position.

4. Set the UV meter to measure mJ/cm2.
5. Set the range on the meter to 2,000.
6. Connect the cable from the sensor to the UV meter.
7. Turn on the UV meter, and wait until “0 0 0.0” appears on the display.
8. In the wizard screen, confirm that the sensor is positioned correctly,

and click Next.

Continue with “UV measurement” on page 58.
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UV measurement The UV lamps power up and stabilize. (This takes several minutes.) Then,
the print block passes over the sensor and the wizard compares the
measured radiation to the recommended level for each UV lamp and
printing mode. During this process, which takes 20–40 minutes, you need
to monitor the progress as displayed in the wizard screen.

Figure 6-91: UV measurement progress

When using a stand alone radiation meter, reset the meter and enter the
reading (measurement) when you are prompted to do so.

Figure 6-92: UV measurement dialog box

If the UV level measured is not acceptable, the wizard calibrates the UV
lamp by adjusting the current supplied to it, and then tests it again.
When all UV tests have finished, the results are displayed, showing the
condition of the lamps after calibration (see figure 6 93).

Figure 6-93: Results and condition of UV lamps after calibration
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After examining the UV calibration results:
1. Click Next.
2. Remove the UV sensor and close the printer cover. After confirming

the items listed in the wizard screen, click Next.

Figure 6-94: Final UV Calibration Wizard screen

Calibrating the 
Load Cells

Load cells are sensors that measure the weight of the material cartridges
and the waste container in the printer. It is important that you periodically
check that the weight measurements are accurate, both for convenience and
to prevent unnecessary waste of printing materials. It is recommended that
you calibrate the load cells once a month.

To calibrate load cells:
1. Start the Load Cell Calibration wizard from the Options menu (see

figure 6 8 on page 11).
2. In the following screen, select one or more load cells that you want to

calibrate.

Figure 6-95: Load cell selection

3. Remove each selected cartridge from the materials cart, and click Next.
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4. In the next wizard screen, observe the numbers and wait until the level
is relatively stable—two units above or below the average level shown.

Figure 6-96: Level stabilization

5. Select the check box, and click Next.
6. Click Done in the final wizard screen.

Figure 6-97: Final wizard screen
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Replacing the 
Odor Filter

If the printer exhaust is not connected to an external ventilation system, a
built in activated carbon filter removes odors from printing materials. This
filter should be replaced regularly (as necessary) to keep your working
environment pleasant. This is normally done during the preventive
maintenance service visit.

Replacing the 
UV Lamps

The UV lamps used for curing models have a long, but limited, working
life. The Stratasys service engineer tests their effectiveness during regular
maintenance checks, and replaces them, if necessary. You can test and
adjust their effective power with the UV Calibration wizard (see “Testing
and Calibrating the UV Lamps” on page 53. If you need to replace a UV
lamp, follow these instructions:
1. Make sure the printer is in offline mode.

Figure 6-98: Offline mode indicator (red)

The online/offline button at the bottom of the printer interface should be
red. If not, click it to switch the printer to offline mode.

2. Start the UV Lamp Replacement wizard from the Options menu (see
figure 6 8 on page 11).

3. Make sure that the build tray is empty, and confirm this in the wizard
screen. Then, close the printer cover and click Next.

Figure 6-99: “Empty tray” confirmation screen

The axes move to the “home” position.

WARNING:  Before continuing, make sure that the safety interlock is not 
defeated, and that the lamp is not hot.
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4. Select the UV lamp(s) to be replaced and click Next.

Figure 6-100: UV lamp selection screen

5. Disconnect the UV lamp power connector and the UV heat fuse
connector.

Figure 6-101: Disconnecting the UV lamp 

Note: Do not disconnect the power connection to the cooling fans.
6. Loosen the screw securing the UV lamp cover (A), and pull the cover

up (B), then out (C).

Figure 6-102: Removing the UV lamp cover
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7. Pull the lamp reflector out of the print block.

Figure 6-103: Removing the UV lamp reflector

8. Inspect the new lamp reflector, and make sure that a black strip is
attached to the inside of it. If not, install one—on the side of the
reflector opposite (not next to) the print block.
Note: Extra black strips are included in the printer Start-up Kit. If 
necessary, you can remove the black strip from the old reflector and install 
it in the new reflector (as long as the black paint has not faded).

9. Discard the old reflector and lamp.

Dispose of the used UV lamp in accordance with environmental and safety 
requirements.

WARNING:  Broken lamp hazard.
UV lamps contain mercury. Deal with broken lamps with caution.

Ventilate the room thoroughly.
Use protective gloves when collecting mercury and lamp components.
Remove spilled mercury with a method that prevents the generation of 
mercury vapor, such as a syringe, packing tape or paper. 
Place the broken lamp, mercury and contaminated materials in an air-
tight, non-metallic container. 
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10. Insert the new UV lamp/reflector unit into the housing next to the print
block.

Figure 6-104: Print block and UV lamp assembly, showing correct placement of 
black strip

11. Replace the lamp cover by inserting it into the slot on the bottom of the
housing, and tighten the securing screw on top.

Figure 6-105: Replacing the lamp cover

12. Reconnect the power and heat fuse connectors.

Figure 6-106: Connecting the UV lamp
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13. In the wizard screen, confirm that you have replaced the lamp(s) and
that the black strip is attached, then click Next.

Figure 6-107: UV-installation confirmation screen

The wizard operates the lamps and checks if their power is within the
acceptable range for each printing mode. (The mode currently being
checked appears in the lower left corner of the printer interface.)

Figure 6-108: Status screen during UV lamp check

14. After replacing a UV lamp, it is recommended that you calibrate its
power for the various printing modes. The next screen allows you to
continue to the UV Calibration wizard (see “Testing and Calibrating
the UV Lamps” on page 53).

Figure 6-109: Final wizard screen
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Built-in Tests The printer application contains a suite of tests for regularly checking the
hardware and software, and for troubleshooting. You can configure basic
communications and environment tests to run automatically, when the
Stratasys software opens. In addition, you can run a more comprehensive
set of tests before processing a print job, as a system check, to ensure
optimum printing results.
Because running the tests effects the operation of the printer, you can only
open the Built in Tests interface when the system is not printing.
The test suite features:
• The organization of printing related tasks in categories:

Communications
Data cards
Temperatures
Voltages
Encoder repeatability
Print head heating
Print head filling

• A clear display of test results and the source of any failures, enabling
you to determine if printing is possible or worthwhile.

• The ability to monitor test results for specific components.
• Troubleshooting tips.
Running these tests can help identify problems in the printer hardware and
software. A large number of hardware defects (or near defects) warns you
of possible printing problems, either for current or future jobs.

Accessing
Built-in Tests

To open the Built-in Tests screen, do one of the following: 
• From the Options menu, select Built-In Tests.
• Press Ctrl+Alt+B.

Figure 6-110: Selecting Built-In Tests from the Options menu

Stratasys recommends running the built-in tests in the following cases:

as a routine test, once every two weeks
as a system check, before major (long) jobs
as needed, for troubleshooting
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Test Interface The Built In Tests screen lists pre configured tests, grouped by component
categories. In this screen, you select and run tests, and the results are
displayed.

Figure 6-111: Built In Tests screen

Test List Test Name
This column lists all of the tests, together with selection check boxes.
Click the check boxes to select the tests you want to run. To remove a
selection, click the check box again. To quickly select all of the tests in a
component category, use the Group drop down list at the bottom of the
screen.

Group
This column shows the component categories for each test.
This tells you which tests are run when selecting a category from the Group
drop down list at the bottom of the screen.

Status
This column shows the results of each test after you run it:

Test successfully completed.

Test failed.

Unknown results. (The test has not been run yet.)
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Test Selection Area In the Test Selection area, at the bottom of the screen, you can quickly select
or de select tests by their characteristics:

Running Tests To run the selected tests:
Click .

Test Results To save and view a report of all of the tests:
Use the Save and View command buttons (see below).

All Click to select all of the tests in the list.

None Click to de select all of the tests in the list.

Unknown Click to select all test that have not been run yet (Status = ?).

Group Use this menu to select tests by component category.

Selection 
Set

Use this menu to select a pre configured set of tests to run at
specified times (computer startup, before printing, etc.).

After you run a test, the Save and View command buttons are added to the 
Built In Tests screen (see below).
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Command Buttons You click the command buttons, on the right side of the screen, to perform
the following operations:

Run
Click to run the selected tests.

Reset
Click to clear previously run tests. This returns the status of each test to
Unknown (?).

Save
Click to save a report that summarizes the tests run. The report is saved as
an HTML file. You can save any number of reports for the tests you run; the
name of the file saved is BITReport [date][time].htm. By default, these files
are saved in the Stratasys installation folder, but you can save it in any other
folder.

View
Click to display the latest test report that you saved. (You can view other
test reports by opening the relevant files in your Web browser. To do so,
open Windows Explorer, and double click the BITReport file.)

Close
Click to close the Built in Tests screen.

Summary On the right side of the screen, a symbol represents the combined results of
all the tests run, using the symbols from the Status column.

All tests successfully completed.

At least one test failed.

Not all tests performed.
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Test Descriptions
and

Troubleshooting

The following table lists the name of each test in the Built in Tests suite,
together with its description and a possible reason for its failure. If you
need assistance, contact your Stratasys service provider.

Test Name Description Possible Reason for Failure
Sub System
Communication

Tests communications between Eden
components.

•Disconnected communications cable.
•Faulty cable.

FIFO Non Interrupt/
FIFO Interrupt

•Tests the data queue in the DATA PCI
card.

•Tests the Windows interrupt.

•If both FIFO tests fail:
Faulty DATA_PCI card.

•If only the FIFO Interrupt test fails:
Faulty Windows interrupt.

Encoder Tests the encoder s reliability by
comparing readings from multiple runs
along the X axis.

Faulty encoder.

System Info Compares the following parameter
values with the minimum
requirements.
•physical memory
•available memory
•free space on disk
•monitor resolution

Failure of RAM memory allocation in the
printer computer.

RFID Verifies the presence of RFID tags on all
loaded material cartridges, and tests
them by writing to and reading from
each one.

•Faulty RFID reader.
•Faulty RFID reader power supply.
•Faulty or misaligned RFID tag.
•High level of electromagnetic noise

around the RFID tag.
System Voltages Checks if the following voltages are

within 5% of the required voltage:
•40V to the print heads by the VPP

power supply
•12V to the height thermistors by the

VDD power supply

•VPP power supply:
Faulty head drive(s).

•VDD power supply:
Faulty height thermistor(s).

Block Filling Analyzes the thermistor readings when
the block is full and when it is empty.

Faulty thermistor.

Interlock Tests the interlock in the printer cover. •Failure of interlock mechanism.
•Faulty latch.
•Disconnected cable.

Cabin Temperature Tests the temperature level in the
build tray area.

Faulty temperature sensor (OHDB).

Head EEPROM Tests the read/write capabilities of the
print head driver cards.

Faulty print head driver card(s).

Head Voltage Checks the control of voltages supplied
to the print heads.

Faulty print head driver card(s).

Head/Block Heaters Tests the heaters in the print heads and
in the print block body.

Faulty heaters or thermistors.

UV Lamps Tests each UV lamp at the High Quality
power level.

Faulty UV lamp.
Faulty UV power supply.
Disconnected UV cable.

Axes Limit Tests the hardware and software limits
of all axes.

Faulty hardware sensors.
Wrong Max Position parameter.

Parameter Sanity Check Compares the values of all printer
parameters (in cfg files) to the required
values.

One or more of the printer parameters is
not within the required range.
Details appear in the BIT report.

Vacuum Tests the vacuum level in the print
block.

•Faulty vacuum sensor.
•Vacuum leakage.
•Wrong parameters.
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Replacing the 
Waste 
Container

Printer waste contains partially cured polymeric material, collected during
normal operation and maintenance of the printer. For safety and
environmental reasons, this material is kept in a special leak proof,
disposable container.
The container has a capacity of 10 kilograms of waste material—usually
enough for several months of printer use. The printer application displays
a warning message when there are 9 kilograms of material in the container,
and stops the printing when the net weight reaches 9.5 kilograms. Above 9
kilograms, the software does not allow you to start a print job (or a printing
activity) until you replace the waste container. You can monitor the weight
of the waste container in the Maintenance screen of the printer interface. You
can also visually inspect the level of waste in the container. (To access it, see
page 73.)

To monitor the waste weight (and other indicators) in the printer:
In the main printer interface screen, click the display toggle to view the
printer indicators.

Waste weight

Display 
toggle button
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Figure 6-112: Printer interface, showing waste weight (red background indicates 
operator alert)

The waste container consists of a plastic container inside a cardboard box.
You typically dispose of the entire waste container—including the box.
Therefore, you must assemble a new box and insert a new plastic container
before you can install it in the printer.

To prepare a new waste container:
1. Assemble the cardboard box, making sure to punch out the perforated

sections.
2. Place a new plastic container into the box.

Note: Do not close the box until you connect the waste drain tube from the 
printer.

Waste weight

Display 
toggle button

Replacement boxes, plastic containers, and sealing caps are supplied in the 
Stratasys printer start-up kit and in the preventive-maintenance kit.
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To replace the waste container:
1. Locate the door on the lower left side of the printer.
2. Push in the top center of the door to release the latch and open the

door.

Figure 6-113: Accessing the waste container

3. Carefully slide out the waste container to remove it from the printer.
4. Close the full container with the cap supplied with the new waste

container.
5. Close the new waste container box, using tape to hold it closed.

• The container should be on the extreme right side of the
compartment.

• Make sure that the waste drain tube is not crimped and that it is not
pinched by the container.

6. Close the waste compartment door.

Cleaning the 
Exterior Panels

The painted exterior plastic panels of Stratasys 3D printers have a durable
finish, offering excellent chemical resistance to common cleaning materials.
Follow the recommendations below when cleaning these areas of the
printer.

Acceptable Cleaning Agents
• mild soap solution
• common household cleaners and window cleaners
• common commercial and industrial detergents, 5% solution in water
• alcohol (ethanol, isopropanol), 10% to 40% solution in water
Wipe the exterior of the printer, using a soft cloth moistened with the
cleaning solution.

Dispose of the full waste container in accordance with environmental and 
safety requirements.
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Unacceptable Materials
• industrial solvents
• cleaning agents containing hydrocarbons, ketones, esters and lacquer

thinners
• spray disinfectants
• abrasives and agents which could wear away the panel finish
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Removing Models After Printing
After printing models, you should allow them to cool as much as possible
before handling them. If additional models do not have to be produced on
the printer, it is best to let the printed models cool in the printer, with the
cover closed, as long as possible.

If the printer must be used to produce additional models as soon as 
possible:
1. Let the printed models cool on the build tray for at least 10 minutes.
2. Very carefully, remove the models from the tray with a scraper or

spatula (supplied in the tool kit), taking care not to pry or bend the
model.

3. Place the models on a flat surface, and cover them with a cardboard
box or paper hood.
This allows the models to cool slowly and evenly.

4. Let the models cool for several hours.

Removing the Support Material
After printed models have cooled, the support material must be removed.
This can be done by different methods, depending on the size of the model,
how delicate it is, the amount and location of the support material, and
other factors. Use the following methods as a guide, and adapt them (or a
combination of them) for finishing the models you are handling.

Removing Excess
Support Material by

Hand

While wearing protective gloves, break away excess support material on
the outside of the model. For delicate models, use a toothpick, pin or small
brush after dipping the model in water.

Removing Support
Material with Water

Pressure

For most models, the most efficient way to remove support material is by
using a high pressure water jet. One suitable system is the Balco WaterJet
cleaning unit. This device is marketed by Stratasys.

WARNING:  Wear protective gloves when handling printed models 
before they are washed.
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Figure 7-1: Balco WaterJet Cleaning Unit

To clean a model using this device, you place it in the chamber, and you
manipulate it and the jet using the built in, waterproof sleeves. A pump
turns ordinary tap water into a high pressure jet, and a wiper keeps the
window clear.

Removing Support
Material with

Caustic Soda

Soak models in a 1 percent solution of caustic soda (sodium hydroxide) to
remove support material from difficult to reach areas and to give the
model a smooth, clean finish. The amount of time you soak the model in the
solution depends on how delicate it is and how much support material
needs to be removed, but it is typically between half an hour and several
hours. In any case, you should remove as much support material as
possible before the caustic soda treatment, and rinse the model thoroughly
(with a water jet) afterwards.

Use caution when cleaning delicate models with high-pressure water systems.

WARNING:  Caustic soda may cause chemical burns, scarring and 
blindness. Mixing it with water generates heat that could ignite other 
materials. Never pour water into a caustic soda solution. When diluting 
the solution, always add caustic soda to water. Take adequate safety 
precautions; always use nitrile gloves when handling caustic soda and 
models soaked in it.
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Post-Printing Treatment for Models Printed with Objet VeroClear
Models made with Objet VeroClear (RGD810) have a slight yellow tint
when removed from the printer. This is especially true for models printed
with a glossy finish. The yellow tint fades naturally over time, but you can
greatly accelerate this process by using a suitable photobleaching
treatment.
As a rule, best clarity is achieved when parts are printed with a matte
finish, and treated as explained below.
Photobleaching models involves exposing them to light. To achieve highly
controlled and predictable results, a professional illumination chamber is
recommended. However, adequate results may be obtained using ordinary
desk lamps fitted with suitable fluorescent elements.

Photo-
Bleaching 
Instructions

Follow these instructions for photobleaching printed models.
• The fluorescent lamps should be rated 45W, 6500K.
• When using desk lamps, place the models in a container lined with

aluminum foil. Use at least two lamps, more when treating models in a
large container.

• Arrange the models with enough space between them to allow light to
reach all sides of each model.

• Verify that the ambient temperature around the models is
approximately 40 ºC (104 ºF). Higher temperatures may cause model
distortion; lower temperatures may not produce satisfactory results.
When using desk lamps, you can achieve the required temperature by
positioning the lamps approximately 10 cm (4 in.) above the models.

• Inspect the models after six hours of treatment.
For parts with a matte finish, this should be enough. Polish and
lacquer the parts.
For parts with a glossy finish, continue the photobleaching
treatment for up to 18 hours more.

In Stratasys laboratories, there was a tint reduction of approximately
70% within six hours. After 24 hours, tint was reduced by
approximately 90%.

Figure 7-2: Illumination chamber Figure 7-3: Desk lamps

More information about this treatment is available in the application note 
VeroClear RGD810 Model Material.
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Storing Models
Models are cured as they are printed, making them safe and stable for a
long time. However, proper storage conditions are necessary to prevent
deforming.
• Keep printed models at room temperature and in a low humidity

environment.
• Do not expose models to direct sunlight and other heat sources.
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